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Début Rapide 
KoolMoves adopte une approche de création d’animations 
Flash ™ qui s’inspire du travail des auteurs de dessins 
animés ; il a d’ailleurs été conçu par un animateur 
professionnel. C'est un logiciel d'animation abouti, avec 
pour choix de conception la facilité d'utilisation et la 
puissance d’expression. Tout ce que l’utilisateur a à faire 
pour créer des animations avec KoolMoves est de dessiner 
ou d’importer des formes ou des photos et puis de 
positionner, remodeler et colorier les objets à animer dans 

des images clé [key frames] misent bout à bout pour aboutir à la présentation 
voulue. KoolMoves réalise les anamorphoses [morphs] automatiquement entre les 
formes créés pour calculer une animation fluide. C’est comme d’assembler des 
images d’un dessin animé. Chaque image contient le texte, les photos, les formes, 
les sons et les actions. Pour restituer le mouvement d’un personnage on le dessine 
dans un certaine attitude dans une première image et on lui donne une autre 
attitude dans l’image suivante. 
 
L'aide est écrite principalement pour les interfaces utilisateur Avancé / Conception 
d’un dessin animé [Advanced : Cartooning] . Une aide de contexte étendue est 
proposée sur les écrans principaux. Recherchez–la en général dans le coin supérieur 
gauche de l’écran. 

Interfaces de niveau d’utilisation 
Dans le souci de présenter à l'utilisateur l'interface la mieux adaptée à son niveau 
de compétence, KoolMoves dispose de quatre modèles d'interfaces utilisateur. 
L'utilisateur peut choisir celle qu’il veut employer dans la barre d’outils située dans 
la partie supérieure droite de KoolMoves, et également dans le dossier File > 
Preferences > View. 
Le tableau ci-dessous indique les fonctionnalités de chacun des modèles d'interface. 
 
 Wizard  

(Assistant) 
Basic 
(Interface 
de base) 

Advanced  
(Interface 
avancée) 

Cartooning 
(Dessin 
animé) 

Création de banière X    
Création de diaporama X    
Effets  X X X X 
Outils de dessin   X X 
Contrôle de forme   X X 
Texte dynamique   X X 
Masquage   X X 
Script d’action   X X 
Composants   X X 
Interpolation non linéaire    X 
Squelette    X 
 

Administrateur
Note
Marked définie par Administrateur
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Barre d’outils des niveaux utilisateur 
Ci-dessous le barre d’outils pour le niveau utilisateur de base avec des icônes 
commentées. 

 

 
 

 
 
← Choisir ou déplacer des formes et des textes dans la fenêtre d’édition 
 
← Insérer effets de textes, boutons, clips arts, interfaces web 
 
← Insérer du texte 
 
← Insérer des images 
 
← Dessiner des ellipses ou des cercles 
 
← Dessiner des rectangles ou des carrés 
 
← Appliquer des effets aux objets formes outextes sélectionnés 
 
← Redimentionner les objets formes ou textes sélectionnés 
 
← Appliquer des couleurs, effets de gradient, motifs de remplissage d'image 
aux objets sélectionns 

 
 
 
 

 
� 
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Barre d’outils du niveau utilisateur avancé 
Ci-dessous la barre d'outils du niveau Utilisateur avancé, avec le commentaire des 
icônes. 
 

 
 

 
Certain icônes de la palette 
d’outils ont un sous-menu 
tiroir  
Cliquer sur le petit triangle de 

la barre d’outils ou maintenez sur la palette la souris quelques instants pour 
sélectionner l’option. 

Outils les plus importants 
Les outils suivants sont les plus utiles 
(affichés par les niveaux « Avancé » et 
« Dessin animé » [Cartooning]. 
Une série de trois outils sont disposés sur 
la barre d’outils du haut : 
Propriétés de la forme (affichée ici) 
Score / Timeline 
Aperçu du film [Movie Overview ] 
 
Copie de l’image [frame] courante pour 
créer l’image suivante. Une des tâches 
fondamentales de l’animation est de 
recopier l’image clé [key frame] courante 
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comme point de départ de création de l’image clé suivante. KoolMoves propose un 
environnement d’édition totalement WYSIWYG [Vous obtenez ce que vous voyez]. 
L’apparence des formes tracées dans chaque image clé est ce que vous obtiendrez à 
l’exécution Flash (à l’exception des effets basés sur des scripts d’action). Pour 
reprendre cet important concept, le processus de création d’une animation implique 
a) recopie de l’image clé courante [key frame] comme point de départ de l’esquisse 
du tracé de l’image clé suivante, b) modification des formes dans cette nouvelle 
image clé, etc. 
 
Cliquer le bouton rose en forme de touche « Play » de magnétoscope pour obtenir 
un menu proposant quatre façons de jouer l’animation. Pour exporter votre 
animation comme un film Flash™, sélectionnez simplement le menu « File / Export 
Movie » pour créer un fichier Flash .swf, un fichier Flash accompagnant une page 
HTML, ou pour ajouter une animation 
Flash à une page web existante. Il est 
particulièrement recommandé de lire la 
section d’aide sur l’ajout d’une animation 
à une page web. 

Tutoriels et autres thèmes d’aide 
Vous disposez d’exemples d’animations 
créées avec KoolMoves en visitant le 
dossier « Examples », la plupart du 
temps placé dans C:\Program Files\KoolMoves\Examples. 
 
A la suite de cette introduction un certain nombre de thèmes sont proposés pour 
vous guider dans la création d’animations de qualité avec KoolMoves, puis de les 
exporter vers le Web. 
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Anamorphose 
L’anamorphose [morphing] est une technique de transformation géométrique 
continue d’une forme en une autre forme. 
KoolMoves prend automatiquement en charge l’anamorphose entre deux images 
clés quand il y a plus de deux trames jumelles entre ces deux images en appliquant 
une interpolation linéaire entre les formes qui ont été déplacées d’une image à 
l’autre. Pour empêcher l’anamorphose, placez à zéro le nombre de trames pour 
cette partie de l’animation. Pour calculer l’anamorphose entre deux images, 
KoolMoves doit identifier le rapport de forme entre elles. Si une image clé en fin 
d’animation contient deux formes A et B et que cette image est recopiée à la suite, 
les formes A’ et B’ de cette image seront liées aux formes A et à B de l’image clé 
précédente par le procédé de recopie ; de cette façon une anamorphose correcte 
sera produite. L’anamorphose intervient entre une forme et ses formes 
correspondantes simples dans l’image clé suivante. Il ne peut y avoir 
d’anamorphose entre une forme simple et des formes multiples et vice versa. 
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Assistant Diaporama 
Cet assistant crée une succession d’images clé pour héberger un diaporama. Les 
images doivent être présentes dans un dossier unique. L’assistant demande le nom 
du dossier, vous permet d’ordonner les images et de sélectionner le délai d’affichage 
de chacune d’elles. Un simple effet de transition [fade in / fade out] peut être 
appliqué. Vous souhaiterez probablement ajouter des boutons à chaque transparent 
pour donner le contrôle à l’utilisateur. Une future version du logiciel fournira cette 
possibilité. La durée d’affichage des transparents peut être reprise dans une Liste 
des images avec l’icône « Frame duration ». 
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Effets 

Utilisation des effets généraux dans KoolMoves 
Il y a une douzaine d’effets très performants applicables à toutes les formes, groupe 
de formes, textes, animation SWF importées, ou clips vidéo (Fade In/out, Expansion 
[Expand], Rétrécissement [Shrink], Zoom Avant/Arrière [Zoom In/Out]). Ces effets 
se trouvent dans la barre de menu « Effects », dans l’onglet « Effects » de la 
fenêtre popup des « Propriétés [Properties] » ; dans la vue « Effects » du popup 
« Score », et enfin pour l’interface « Utilisateur de base [Basic Skills] » dans la 
barre d’outils. Commencez par sélectionner une forme puis sélectionnez un effet. La 
plupart des effets s’appliquent à plusieurs images clé à la suite dont vous pouvez 
spécifier le nombre au moment de la sélection de l’effet ou ultérieurement en 
utilisant « Effects > Modify » ou en éditant l’effet dans le popup « Properties ». 
Vous pouvez aussi combiner les effets dans bien des cas. Il suffit d’ajouter un 
nouvel effet. 
 
Un type spécial d’effet, nommé « Motion Script » fait appel au langage de script 
d’action sophistiqué de Flash 5 pour être créé. Chacun de ces scripts est largement 
adaptable, mais les « motions scripts » ne peuvent pas être combinés avec les 
autres effets. 
 
L’avantage des effets standard comme atténuation [fade in] et zoom c’est qu’ils 
peuvent s’appliquer à n’importe quel type d’objet et qu’ils préservent les choix de 
couleur, forme et position imposés par l’utilisateur à chaque image séparément. 
L’avantage respectif des effets basés sur des scripts d’action c’est qu’il sont plus 
spécifiques et hautement paramétrisables. 
 
Les formes d’un effet « motion script » sont affichées dans la fenêtre d’édition 
entourés d’une boîte en pointillés bleus. Les autres effets sont affichés dans une 
boîte en pointillés verts. 

Utilisation de modèles d’effets sur les textes [Text Effects Templates] 
KoolMoves fournit une bibliothèque de modèles pour les effets de textes. 
Sélectionnez « Libraries > Text Effects ». Ce sont les fichiers .fun standard de 
KoolMoves qui enregistrent le schéma et le trajet de déplacement des textes. Vous 
saisissez votre texte, sélectionnez la police de caractère [font], et le logiciel calcule 
les effets désirés. Sélectionnez un effet texte à partir de la « Selection of texte 
effects » sur la gauche. Vous pouvez voir l’effet en temps réel sur la droite, en sur 
imposition de l’animation vidéo.  
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Sous l’effet texte animé il y a des boutons coloriés. Chaque bouton représente une 
couleur du modèle [template] . Vous pouvez modifier la couleur du texte en cliquant 
ces boutons et en sélectionnant différentes couleurs. 
Pour repositionner l’effet texte à l’écran, modifiez la valeur de « X Offset » et de « Y 
Offset ». Deux zéros correspondent à un texte centré. 
 
Pour modifier le point de départ de l’effet texte par rapport à l’animation sous-
jacente, sélectionnez « Start at key frame ». Les images qui excèdent la longueur 
courante de l’animation ont l’étiquette « added » entre parenthèses. Le bouton à 
droite vous permet de voir ces images clé. Un effet texte a une longueur d’image 
naturelle qui est exprimée par « End At key frame ». Vous pouvez outrepasser cette 
valeur si vous souhaitez étirer l’effet texte pour recouvrir au delà de l’animation 
sous-jacente. Dans la plupart des cas vous n’aurez pas à modifier la valeur « End At 
key frame ». Modifier celle-ci n’affecte pas la vitesse de l’effet texte, car en étirant 
l’effet texte vous raccourcissez les trames [tweens] intermédiaires. Pour contrôler la 
vitesse indépendamment du nombre d’images clé, positionnez la valeur « Speed » 
entre « Very Slow » et « Very Fast », ou modifiez la vitesse de l’animation principale 
(Menu « Movie > Movie Speed »). La valeur de « Speed » affecte le nombre de 
trames entre les images clés. 
 
Pour ajouter l’effet texte au film sous-jacent, cliquez sur « Add ». Vous pouvez 
maintenant utiliser librement n’importe quel outil de positionnement, coloriage ou 
transformation pour éditer l’effet texte, ou annuler cet effet avec le bouton 
« Undo ». 
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Si vous voulez que la dernière image de l’effet texte dure plus longtemps, 
augmentez le nombre de trames [tweens] de l’image clé précédente, ou dupliquez 
la dernière image clé plusieurs fois en utilisant le menu « Frames > Insert Copy 
of Frame ». Vous pouvez aussi utiliser « Edit > Paste to End of Movie » pour 
coller les caractères de l’effet texte sur le reste de l’animation. 

Créer votre propre effet texte 
Il est facile de créer votre propre effet texte. Le principe de base c’est de créer les 
étapes de l’effet texte dans une succession d’images clé. Cet exemple illustre une 
série de lettres qui apparaissent au départ 
à l’écran très grandes et transparentes.  
 
A l’étape 1, l’outil texte est cliqué et une 
lettre unique saisie. La taille de de la lettre n’a pas d’importance car nous allons en 
modifier l’échelle. La lettre apparaît à droite. 
 
A l’étape 2, la lettre est mise en transparence avec l’outil de remplissage [paint 
bucket tool].  
 
A l’étape 3, la lettre est beaucoup 
agrandie avec l’outil de changement 
de taille [scaling tool].  
 
A l’étape 4, l’image clé courante est 
copiée et ajoutée à la fin du film. 
 

 
 
A l’étape 5, à la dernière image clé, 
la taille de la lettre est réduite avec 
l’outils de changement de taille et la 
transparence supprimée avec l’outils 
de remplissage. 
 
 

 
 
 
L’image clé courante est recopiée à la fin du film et le 

processus est répété pour la lettre suivante, ici « o ». Et ainsi de suite 
pour chaque lettre. Le réglage de la taille de chaque lettre sera nécessaire pour 
produire une présentation sans à coup. 
 
Quand l’animation est jouée, l’effet est de faire apparaître chaque lettre en 
séquence. Les effets textes que vous pouvez créer sont infinis. 
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Créer vos propres transitions 
La création de transitions est aisée. Le principe de base est de créer les étapes de la 
transition sous forme d’une suite d’images clé. L’exemple suivant illustre le passage 
d’un motif de gauche à droite dans une image ; d’abord transparent et de petite 
taille il devient de plus en plus opaque et s’agrandit en s’approchant du centre de 
l’image. Nous parlerons ensuite de plusieurs des transitions fournies par 
l’application. 
 
A l’étape 1 une imagette est importée avec le menu File > Import Graphic 
Image. Pour démarrer la transition elles est glissée / déposée dans la partie gauche 
de la fenêtre de l‘animation. 
  
A l’étape 2 l’imagette est réduite et rendue transparente avec les outils de réduction 
d’échelle et de remplissage. 
 
A l’étape 3 l’image clé 
courante est copiée et 
ajoutée en fin d’animation. 
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A l’étape 4 l’imagette est déplacée au 
centre de la nouvelle image clé.  
 
 
 
 
 
 
 
 

Et pour finir avec les outils Remplissage 
et de Changement d’échelle on supprime 
la transparence et on ramène l’imagette 
à sa taille d’origine. 
 
Quand l’animation est jouée, l’imagette 
glisse de gauche à droite en grandissant 
et en s’opacifiant. Les transitions 
possibles sont infinies. 
 
 

KoolMoves dispose de six transitions intégrées – l’estompage [fade-in] initial, 
l’estompage [fade-out] final, la croissance initiale [grow-in] à partir de rien, la 
réduction [shrink] finale jusqu’à disparition, le zoom positif initial, et le zoom négatif 
final. Elles prennent effet au début ou à la fin de l’existence de la forme à laquelle 
elle s’appliquent selon que c’est une transition dite initiale ou finale. Ces transitions 
peuvent être appliquées à la forme sélectionnée dans le menu pop-up des 
Propriétés ou dans la barre de menu des Effets. Les transitions interviennent sur un 
nombre paramétré d’images clé. Quand une transition est ajoutée à une forme, des 
images sont ajoutées si la case « Add frames if needed » est cochée et si leur 
nombre était initialement insuffisant pour que la transition s’applique. Les 
transitions peuvent être combinées bien que les estompages [fade] ne soient pas 
recommandés avec les effets d’ombrage. 
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Scripts d’animation [Motions scripts] 
Les « motion scripts » sont des scripts d’actions en langage de programmation Flash 
5 qui s’appliquent  aux formes sélectionnées. Les scripts d’actions ne sont pas 
affichables dans l’environnement d’édition de KoolMoves mais sont ajoutés quand le 
fichier .swf est créé. Parce que le dispositif d’affichage interne de KoolMoves ne sait 
pas interpréter les scripts d’actions, tout ce que vous verrez c’est une boîte 
pointillée bleue englobant la forme. Quand on joue l’animation dans la fenêtre 
d’aperçu associée au script d’actions, dans un navigateur web ou dans une 
visionneuse indépendante Flash, l’effet du script d’actions devient visible. 
 
En raison de la nature de ces effets basés sur des scripts, les modifications image 
par image de couleur, de forme et de position sont ignorées. La position, la couleur 
et la transparence de la première image clé où la forme apparaît est utilisée par 
l’effet. La durée de l’effet est déterminée par l’effet lui-même et non par le nombre 
de trames où la forme apparaît. De même l’effet d’ombrage n’apparaît pas quand un 
script d’animation est appliqué. Si le texte est une lettre isolée ou si l’effet est 
appliqué à un objet non textuel, les paramètres d’effet tels « de gauche à droite » 
ou « de droite à gauche » ne s’appliquent pas. 
 
Pour les utilisateurs avancés qui souhaitent contrôler l’effet sur l’animation 
principale grace à des commande de script d’une action comme stop(), le nom de 
l’animation [movie clip] qui contient cet effet doit avoir le même nom que la forme 
dans la liste de formes de KoolMoves. Si un espace est encapsulé, celui-ci est 
supprimé. 
 
Vous pouvez créer vos propres scripts d’actions et les utiliser dans vos animations. 
Lire le fichier readme.txt dans le dossier « My Scripts » du dossier « Motion 
Scripts » pour plus d’information. 
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Ajout à une page Web  
L’exécution d’une animation Flash depuis une page Web implique : (1) de créer un 
fichier .swf avec KoolMoves ; (2) d’ajouter à la page Web le code javascript qui 
référence le fichier swf. KoolMoves va créer ce code javascript pour vous. A la fois 
les fichiers swf et javascripts seront téléchargés sur votre serveur web. Ce 
processus est analogue à la création d’une image avec un outil d’édition graphique 
puis à sont insertion dans une page web pour qu’elle soit affichée par un navigateur 
web. Consultez le dossier File > Export Movie pour un certain nombre d’approches 
différentes dans la création de fichiers swf et l’ajout du code ad hoc à une page 
web. 
 
Si vous voulez générer des gif animés, utilisez File > Export Movie > Capture 
Movie Frame pour capturer la portion de l’écran dans la fenêtre du film d’animation 
et sauvegardez la comme fichier .bmp. Capturez une série de trames (i.e. naviguer 
jusqu’à une trame, capturer celle-ci, aller à une autre trame, probablement la 
suivante, la capturer à son tour, et ainsi de suite). Et utilisez un logiciel de création 
de gifs animés pour générer une animation optimisée à partir des fichiers de capture 
.bmp. Il y a de nombreux outils spécialisés pour ce type de création. Voir la page 
d’aide « Gif Creation ». 
 
Utilisateurs de FrontPage : voir « Utiliser KoolMoves avec Frontpage ». 
Utilisateurs de CoolPage : voir « Utiliser KoolMoves avec Cooltpage ». 
Utilisateurs de NetObject Fusion : voir « Utiliser KoolMoves avec NetObject Fusion ». 
 
Une animation KoolMoves peut être exportée comme animation Flash ™ (format 
.swf) avec le menu File > Export Movie > Save as Flash Movie. Vous pouvez 
créer un fichier .swf indépendant, un fichierr .swf et un squelette html qui référence 
ce fichier swf, ou ajouter une animation Flash à une page web existante. Les fichiers 
swf et html sont simultanément nécessaires pour que l’animation s’exécute sur 
l’Internet. Les propriétés de l’animation (dimension, vitesse de défilement, couleur 
de fond ou image de fond) peuvent être positionnées avec les options du menu 
associées à de la barre de menu Movie avant l’exportation des fichiers. 
 
KoolMoves peut vous fournir le code javascript nécessaire à l’appel de l’animation 
Flash ; c’est une option du menu File > Export Movie > Add to Existing Web 
Page. Pour remplacer une image gif ou jpeg dans un fichier HTML existant par une 
animation Flash, remplacez à la main le morceau de code HTML <IMG SRC="…gif " 
WIDTH="…" HEIGHT="…" BORDER="0" ALT="…"> dans le fichier HTML 
existant par tout le morceau de code javascript proposé par KoolMoves et qui 
commence par <OBJECT et se termine par </OBJECT> en commençant par 
recopier le code <OBJECT … puis en le collant par dessus le code <IMG … 
Vous pouvez utiliser pour cela l’outil d’édition copier / coller du presse papier de 
votre éditeur HTML ou de l’éditeur BlocNote. Un mot d’avertissement : ne collez 
pas ce code javascript dans une page utilisant FrontPage. Le code serait collé 
dans un boc de texte et le script javascrit mal exécuté. 
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Le nom du fichier .swf dans le fichier HTML doit être le même que le nom du fichier 
.swf sur le serveur web. Si votre serveur n’accepte pas l’extention de fichier .html 
vous pouvez renommer celle-ci .htm. Il est préférable de n’inclure ni espace ni 
caractère accentué dans le nom des fichiers car cela pose des problèmes avec le 
navigateur Netscape. 
 
Ensuite téléchargez le fichier .html ainsi que le fichier .swf sur votre serveur par 
FTP. Lors du transfert du fichier .swf vers le site serveur assurez-vous de configurer 
le transfert en mode binaire. Par contre les fichiers .html ou .htm doivent être 
envoyés en mode ascii. Le mieux est d’utiliser des programmes comme FtpVoyager 
qui se configurent automatiquement pour le transfert. La page web 
http://www.pagesource.com/putweb/ vous aidera à transférer des fichiers vers 
votre serveur. 
 
Si vous avez des difficultés à exécuter l’animation sur Internet, voici comment 
procéder : 
Si vous double-cliquez sur le fichier .html généré par KoolMoves sur votre disque 
local, l’animation s’exécute-t’elle dans le navigateur par défaut ? Si c’est le cas c’est 
que les fichiers .html eet .swf sont corrects. Sinon c’est que votre navigateur ne 
dispose peut-être pas de la visionneuse Flash de Macromedia. Allez par Internet sur 
le site de votre navigateur ou sur le site http://www.macromedia.com/ et 
téléchargez la visionneuse. 
 
Téléchargez les fichiers .html (ascii) et .swf (binaire) vers votre serveur Web. 
L’animation s’exécute-t’elle sur le serveur quand vous affichez la page web générée 
par KoolMoves ? Si non, c’est qu’il y a un problème de transfert de fichier. 
 
Voir la rubrique Add to Web Page Details pour des informations plus détaillées. 

http://www.pagesource.com/putweb/
http://www.macromedia.com/
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Capturer une fenêtre d’animation 
Cette fonction réalise la capture d’écran soit de l’image clé courante soit de toutes 
les images clé et les place dans la fenêtre d’animation. Les captures d’écran sont 
sauvegardées au format .bmp, .jpg ou .png. En assemblant une suite d’images vous 
pouvez créer un gif animé avec de nombreux outils d’édition graphique. 
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Importer et exporter des images gif 
KoolMoves supporte l’importation d’images GIF statiques avec ou sans 
transparence, mais pas de Gif animés pour le moment.  
 
Utilisez une application du site http://www.segon.com/ pour convertir vos GIF 
animés en fichier SWF. Puis utilisez le menu Import Swf As An Object pour 
intégrer le fichier converti dans l’animation KoolMoves. 
 
KoolMoves ne supporte pas directement l’exportation de GIF animés pour le 
moment. Pour convertir un fichier .swf créé par KoolMoves en gif animé, vous 
pouvez utiliser Magic Swf2Gif d’Itinysoft.com. 
 
Il y a de nombreuses applications spécialisées dans la création de Gif animés. Ulead 
distribue un joli outil nommé GifAnimator. Il y a aussi des logiciels gratuits. Sur le 
site http://msdowload.microsoft.com/msdowload/gifanimator/gifsetup.exe, vous 
trouverez un petit animateur GIF gratuit de  Microsoft, et par les créateurs de Game 
Maker, à l’adresse http://www.cs.uu.nl/~markov/kids/gmaker/index.html, un 
environnement de création et de développement de jeux très simple d’utilisation. 
 
Capturez une animation KoolMoves sous forme d’une suite de captures d’écran en 
utilisant File > Export Movie > Capture Movie Frame et importez les fichiers 
d’image dans votre générateur de gif animé favori. Avec certains outils d’animation 
gratuits vous devrez peut-être convertir d’abord au format Gif ces fichiers avec un 
éditeur graphique. 

http://www.segon.com/
http://msdowload.microsoft.com/msdowload/gifanimator/gifsetup.exe
http://www.cs.uu.nl/~markov/kids/gmaker/index.html
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Importer une animation Flash en tant qu’objet 
Une animation Flash ™ 
(format swf) peut être 
importée comme un 
objet. Pour importer un 
objet SWF sélectionnez 
soit File > Import Flash Movie as Object ou utilisez le bouton d’importation 
situé dans la palette de l’outil de dessin (la dernière option dans le sous-menu 
tiroir). L’objet SWF peut être positionné n’importe où dans une animation KoolMoves 
et manipulé comme tout autre symbole. Tell Target Actions peut associer des 
commandes sonores stop et play avec l’animation importée.  

 
L’animation a sa propre timeline et ne 
peut pas être visionnée ou éditée dans 
l’environnement d’édition de KoolMoves. 
Elle est affichée sous forme d’un 
rectangle pour indiquer la position et les 
dimensions de l’objet SWF importé et 
vous ne pourrez visionner le film dans 

son entier que dans un navigateur web ou une visionneuse Flash indépendante. 
Vous pouvez redimensionner, étirer, pivoter, déplacer, appliquer un effet et 
retourner un objet SWF. L’objet SWF s’exécutera là où est placé le rectangle qui le 
représentant. L’objet importé conserve tous ses attributs (sons et actions). 
 
Enfin le fichier SWF doit être placé dans le même dossier que l’objet qui le 
référence.
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Actions désignant une cible [Tell Target Actions] 
Tell Target est une moyen de communiquer entre différentes timelines. Toute 
animation peut contrôler toute autre animation. Votre animation a plusieurs timeline 
quand : 
Vous créez un objet SWF ; 
Vous chargez une animation dans une couche [layer] ; 
 
Il y a trois fonctions Tell Target de base intégrées dans KoolMoves. 
Stop 
Play 
Silence [Stop sounds]  
Nous y viendrons plus loin, ces actions étant placées dans la section avancée 
[Advanced section] du menu pop-up Add Action. 
 
Les actions Désigner la cible [Tell Target] agissent comme les actions normales avec 
une différence – vous devez définir une cible dans la boîte des cibles. Dans un 
fichier SWF chaque cible est disposée un peu comme un dossier. Pour accéder à la 
timeline courante de l’animation principale vous devez aller dans /. Ce qui peut être 
fait n’importe où pour contrôler la timeline des animations courantes. La syntax ../ 
peut aussi être utilisée pour contrôler la timeline d’une animation de niveau 
supérieur. Disons par exemple que vous vouliez contrôler la timeline principale 
depuis un objet SWF importé, vous devrez utiliser la syntaxe ../ avec Tell Target. 
Pour les animations chargées vous devez utiliser une syntaxe légèrement différente. 
Pour utiliser Tell target avec une animation chargée vous devez utiliser la syntaxe 
_leveln/ où n est le niveau de l’animation chargée. Si par exemple vous voulez 
contrôler une animation chargée au niveau 1 la cible doit être : _level1/. Pour 
contrôler un objet SWF depuis l’animation principale vous pouvez utiliser la syntaxe 
/Nom_de_l’objet ou simplement Nom_de_l’objet. 



Utiliser Microsoft FrontPage 

Aide KoolMoves – Traduction jean.fruitet@free.fr - 19/171 

Utiliser Microsoft FrontPage 
Consultez le tutorial www.getafine.com/cgi-
bin/merlot/get/koolmoves/tutorials/kmwithfrontpage.doc par The Crate Diseño 
Web. 
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Utiliser CoolPage 
Consultez le tutorial www.getafine.com/cgi-
bin/merlot/get/koolmoves/tutorials/kmwithcoolpage.doc par The Crate Diseño Web. 
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Utiliser NetObjects Fusion 
Consultez le tutorial www.getafine.com/cgi-
bin/merlot/get/koolmoves/tutorials/kmwithfusion.pdf par FusionMagic. 
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Ajouter des animations à une page Web 
Avant de remplir cet écran vous devez avoir créé un fichier d’animation Flash (.swf) 
dans le même dossier que la page web dans laquelle vous voulez afficher 
l’animation. Pour Existing Web page cliquez sur l’icône de dossier. Sélectionnez la 
page web qui recevra l’animation Flash. Pour Flash Movie sélectionnez le fichier 
correspondant à l’animation Flash. L’animation doit être dans le même dossier que 
la page web. Vous pouvez choisir que l’animation soit en tête de page ou qu’elle 
remplace une image existante. L’option Movie Loops vous permet de sélectionner 
une exécution unique dans la page web ou une exécution en boucle.  
 
Cliquez le bouton Test sur la droite pour visionner l’animation dans la page web. Si 
vous ne voyez qu’un rectangle vide là où devrait se situer l’animation c’est que 
probablement votre navigateur web n’a pas de plug-inFlash installé. Vous pouvez 
récupérer ce plug-in sur le site de votre navigateur ou sur 
http://www.macrodedia.com/ . Cliquez le bouton Save As pour enregistrer la page 
web avec son animation. Il est préférable de choisir un nom différent pour le fichier 
de la page web. Si vous choisissez le même nom un fichier de sauvegarde est créé 
pour la version non modifiée avec l’extension .bak . 
 
Si vous souhaitez que l’animation Flash soit référencée par un hyperlien, il vous faut 
ajouter un bouton pointant vers l’animation que l’utilisateur pourra cliquer. Le 
bouton peut être placé sous forme de bouton « Click Me » ou rester invisible et 
emplir toute l’animation. Pour ce dernier cas : 1)  Ajouter un rectangle à la première 
image qui excède légèrement les limites de la fenêtre de l’animation. 2) Rendre 
l’intérieur du rectangle transparent. 3) Faire du rectangle un symbole interactif. 4) 
Ajouter une action Get Url et fournir une référence hyperlien. 5) Copier le rectangle 
sur la trame suivante et coller jusqu’à la fin de l’animation.

http://www.macrodedia.com/
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Ajoutez des détails à une page Web 
Le fichier .html contient une grande section de code Javascript qui affiche une 
image nonflash.gif si le navigateur n'a pas de visonneuse Flash [Flash plug-in] ou 
s’il ne peut pas lire le code Javascript. L’image nonflash.gif n'est pas créé par 
KoolMoves. Vous devez la fournir vous-même. Créez votre propre image au format 
GIF ou JPEG, qui sera affichée si l'animation Flash ne peut pas s’exécuter et 
enregistrez la sous le nom nonflash.gif ou soous un autre nom à condition d’en 
changer la référence dans le code Javascript qui l’appelle. La taille de l’image est 
indiquée à côté du nom du fichier appelé. 
 
Il n’est pas garanti qu'une animation Flash ™ exportée uisse être être importée 
dans Flash Macromedia ™ à des fins d'édition, ni qu’une animation crée dans 
KoolMoves, exportée dans Flash ™ et réexportée dans KoolMoves ait le même 
comportement que l’animation originale de KoolMoves. 
 
La visionneuse Flash ne peut exécuter que des fichiers SWF de moins de 2,5 à 3 MB. 
Quand un fichier SWF a autour de 3 MB, il commence à faire des trucs bizarres. 
Parfois il plantera l’ordinateur. C'est documenté à l’adresse 
www.macromedia.com/support/flash/ts/documents/bigflash.htm . Si vous voulez 
créer une animation excédant cette taille, prennez en considération de n’employer 
que des paramètres Jpeq de qualité réduite ce qui diminuera la taille du fichier, ou 
décomposez l’animation en morceaux et utilisez l’option Load Movie pour charger les 
différentes parties. 
 
Le fichier HTML contient des instructions de paramètrage et exécute le fichier SWF 
dans la portion de la page web où vous avez placé le script. Voici un exemple du 
script HTML Flash que vous devrez ajouter à votre page : 
 
<OBJECT classid="clsid:D27CDB6E-AE6D-11cf-96B8-444553540000" 
codebase=http://active.macromedia.com/flash2/cabs/swflash.cab#version=4,0,0,0 
ID=super WIDTH=560 HEIGHT=60> 
<PARAM NAME=movie VALUE="super.swf"> 
<PARAM NAME=loop VALUE=true> 
<PARAM NAME=quality VALUE=high> 
<PARAM NAME=bgcolor VALUE=#FFFFFF> 
<EMBED src="super.swf" loop=true 
quality=high bgcolor=#FFFFFF WIDTH=560 HEIGHT=60 
TYPE="application/xshockwave- 
flash" 
PLUGINSPAGE= "http://www.macromedia.com/shockwave/download/ 
index.cgi?P1_Prod_Version=ShockwaveFlash"> 
</OBJECT> 
 
Notez qu'il y a à la fois des balises objet et d’encapsulation. L'objet est destiné à 
Internet Explorer et l’encapsualtion à Netscape. Les paramètres sont référencés  

http://active.macromedia.com/flash2/cabs/swflash.cab#version=4,0,0,0
http://www.macromedia.com/shockwave/download/
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dans les deux zones ; ces paramètres vous permettent de faire des adaptations de 
votre animation. 
http://www.macromedia.com/support/flash/ts/documents/tag_attributes.htm 
fournit davantage d'explications sur ces balises d’autres paramètres vous 
permettant d’adapter l’affichage de vos animations. 
 
Le paramètre d’animation référence le fichier SWF de votre dossier. Vous 
devrez télécharger le fichier SWF dans le même dossier que la page Web. 
Si vous placez le fichier SWF dans un dossier différent vous devrez indiquer le 
chemin de ce fichier dans ce paramètre – quelque chose comme flash/super.swf – 
assumant que flash est le nom de ce dossier  particulier. 
 
En positinnant à faux (respectivement à vrai) le paramètre de boucle vous pouvez 
jouer l'animation une fois (respectivement sans interruption). 
 
Le paramètre de couleur de fond bgcolor peut avoir n’importe quelle valeur 
hexadécimale au format #FFFFFF en fonction de votre charte graphique. 
 
La largeur et la taille de l’animation ne sont pas des paramètres au même sens que 
les autres, mais vous pouvez tout de même les modifier. Puisque le 
Fichier de SWF est être redimensioné , vous pouvez faire les adaptaations 
nécessaires et l'animation se redimensionnera automatiquement. 
 
Des dimensions fixes en pixels ou en pourcentage de la fenêtre d’affichage peuvent 
être employés. Les dimensions fixes en pixels (par exemple, WIDTH=300 et 
HEIGHT=200) créent une fenâtre de dimensions exactes, comme pour une photo. 
Les dimensions en  pourcentage -- par exemple, WIDTH=50% et HEIGHT=50%  -- 
redimensionnent la fenêtre de l’animation  en proportion de la taille de fenêtre du 
navigateur, sans déformation. 
 

http://www.macromedia.com/support/flash/ts/documents/tag_attributes.htm
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Dessiner 
 

 Il y a un choix très riche d’outils de dessin dans 
KoolMoves : formes à main levée, primitives 
géométriques (ellipse, cercle, rectangle et carré), et 
formes dessinées point par point. 
La barre d’outils avec des flèches dans la partie 
inférieure droite ont des tiroirs (choix secondaires). 

Vous faites apparaître ces choix secondaires en cliquant sur les boutons de la 
palette d’outils ou en cliquant sur la flèche triangulaire à droite en bas de la barre 
d’outils. Le choix affiché sur la barre d’outils est le choix actif. 

 
 L'outil de dessin à main levée vous permet de 
dessiner comme avec un crayon. Le premier et le 
dernier point sont automatiquement reliés quand 
vous relâchez la souris. Si vous ne voulez pas qu'ils 
soient connectés, modifiez la propriété de fermeture 
[Closed property] de la forme. Les points générés 

par le dessin à main levée sont des morceaux de courbes interpolant un nombre 
réduit de points. Vous pouvez ajouter ou supprimer des points de contrôle 
ultérieurement si nécessaire. 
 
Les outils pour dessiner des primitives géométriques 
en rendent le tracé facile pour tracer des cercles, des 
carrés, des rectangles et des ellipses. Cliquez le 
bouton gauche de la souris à un coin de la forme que 
vous voulez dessiner et glissez la souris au coin 
opposé de la forme. Relâchez la souris et la forme 
est tracée.  
 
Il y a trois options au bas de la palette d’outils : 
remplissage de couleur, couleur des lignes et des 
bordures, épaisseur des lignes et des bordures. Ces 
options sont disponibles pour chacun des outils de 
dessin et positionnées jusqu’à une modification de 
votre part. Modifier ces propriétés n'affecte pas les 
formes déjà dessinées. 

 
 Les formes dessinées 
point par point permettent 
de contrôler le nombre et 
la placement de points. La 
forme est dessinée d’abord 
sans courbures ; celles-ci 

peuvent être ajoutées par la suite. Cliquez le bouton 
gauche pour placer chaque point et continuez jusqu'à 
avoir achevé le tracé. Pour terminer, double-cliquez. Le premier et le dernier points 
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sont automatiquement reliés. Si vous ne voulez pas qu'ils soient reliés, modifiez la 
propriété de fermeture de la forme. 
 
Il y a des cas où une 
forme ne doit pas être 
refermée (par exemple 
le dessin d’un nez), 
sélectionnez l’outil 
polyligne.  
 
Cliquez le bouton gauche pour positionner chaque point et continuez 
jusqu'à avoir achevé le tracé de la forme. Pour terminer, double-cliquez. 
La forme est refermée et sa couleur de remplissage est le blanc par 
défaut.   
 

 Utilisez l'outil de remplissage 
de forme pour la colorier avec 
une couleur chair. La frontière 
n'est pas reliée entre le 
premier et le dernier point 
dessinés. Si plus tard il faut 
refermer la ligne entre le 

premier et le dernier point, modifiez la propriété de fermeture de la forme. Pour 
supprimer la couleur de remplissage et rendre la forme transparente modifiez la 
propriété de remplissage de la forme. Ceci produira une ligne. 
 
 Les formes et les lignes courbes sont définies par 
des points de contrôle extérieurs et intérieurs à la 
forme (indiqués par les cercles tiretés). 
Techniquement, les courbes sont les splines 
quadriques de Bezier.  
 
Vous pouvez modifier la forme de la courbe en 
déplaçant les points de contrôle choisis, dans et hors 
de la forme en les sélectionnant puis en les glissant à la souris ou avec les touches 
de déplacement du curseur. 
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Propriétés des formes 
 
Vous pouvez contrôler l'aspect 
d'une forme [Shape] au 
moyen des propriétés de : 
1) remplissage 
2) épaisseur de bordure 
3) couleur de bordure ou de 
ligne 
4) fermeture 
 
Les lignes sont des formes qui 
ne sont pas remplies et qui ne 
sont pas refermées. Les lignes 
peuvent être transformées en 
formes en positionnant leurs 
propriétés de remplissage et 
de fermeture. Un texte n'a pas de bordure. 
 
Les propriétes des outils de formes et de points sont proposées dans partie 
supérieure gauche de la palette d’outils de dessin. 
 
Pour rendre transparent 
l’intérieur d’une forme 
sélectionnez la propriété 
Filled et choisissez no.  
 
 
 
 
 
 
 
 
 

 
Voici une forme qui n’est pas 
remplie.  
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Pour modifier l’épaisseur 
de la bordure autour 
d’une forme ou d’une 
ligne sélectionnez Line 
Width.  
 
 
 
 
 
 
 

 
 
Voici une forme sans bordure ( i.e., 
Line Width égale à 0).  
 
 
 
 
 
 
 

 
Pour indiquer qu’une bordure est 
refermée ou pas sélectionnez Is 
Closed / yes ou Is Closed / no.  
 
 
 
 
 
 

 
Voici une forme avec le dernier segment 
non tracé. Et quand la forme n’est pas 
non plus remplie nous avons une ligne.  
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La boîte de dialogue 
des propriétés des 
textes a une 
apparence différente 
car les textes ont des 
propriétés différentes 
des formes. La couleur 
d’un texte peut être 
modifiée en cliquant 
sur la propriété Color. 
Une fenêtre de 
dialogue apparaît qui 
vous permet de choisir 
la couleur. Le texte, sa 
police de cractère, sa 

taille peuvent être édités en cliquant sur la propriété de Type. Une boîte de dialogue 
vous permet alors d’éditer le texte. 
 
L’assignation de propriétés à un bouton et la transformation d’une forme non texte 
en symbole sont expliqués à la section suivante. 
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Evènements associés aux images clé d’une animation  
Des sons et des actions peuvent être ajoutés aux images clé d’une animation. 
Affichez Choisissez le menu View / Actions and Sounds overview ou sélectionnez 
l’onglet Actions and Sounds de la fenêtre Score / Timeline. 
 
Avec ces boîte de dialogue, vous pouvez associer des sons et des actions aux 
images clé de l'animation. C'est très simple. Sélectionnez une image clé en cliquant 
sur son nom dans la fenêtre Key Frames. Cliquez sur le bouton + en haut de la 
boîte Action and Sound Overview et parcourez les dossiers pour choisir un fichier 
MP3 ou WAV. Quand l'animation est jouée dans votre navigateur web le son est 
également joué. Il y a aussi un large éventail d'actions qui peuvent être activées 
quand cette image clé est affichée. Cliquez sur le bouton Add Action + dans la 
boîte de dialogue Action. Cette boîte de dialogue fournit également une vue des 
boutons d’actions et des sons. Comme en général un bouton apparaît pour toute 
l’animation ou pour sa majeure partie, les événements de bouton sont énumérés 
seulement à la première image clé quand le bouton est affiché. 
 
Des sons (formats MP3 et wav PCM) peuvent être ajoutés aux animations de 
KoolMoves. Il y a environ 68 différents formats Wav. Pour le moment KoolMoves ne 
supporte que le format PCM. Cliquez sur le bouton Dossier pour sélectionner un 
fichier de sons puis l’icône Sound pour le jouer (un fichier MP3 n’est joué que dans 
une fenêtre de navigateur équipé d’un plug-in Flash…). L’icône de la poubelle 
permet de supprimer un son. L'icône de forme d'onde affichera le fichier audio dans 
l’éditeur audio de votre choix une fois celui-ci paramétré dans le menu File > 
Preferences. 
 
Si vous employez le même fichier audio dans toute l’animation, il sera référencé 
autant de fois dans l’animation Flash ™ mais enregistré une seule fois dans le fichier 
SWF. 
 
Les fichiers audio tendent à être très lourds et rendent le fichier exporté SWF 
énorme. Pour conserver une taille raisonable aux fichiers audio, procédez ainsi : 
dans un éditeur audio convertissez les sons de stéréo en mono et choisissez un taux 
d'échantillonnage qui conserve la qualité dont vous avez besoin. Raccourcir la piste 
audio peut aussi être utile. 
 
Des sons peuvent également être attachés aux différents états d’un bouton (par 
exemple déplacement de la souris au-dessus d'un bouton ou presser sur un 
bouton). Lire la rubrique Associer des sons à un bouton pour plus d’information.  
 
Les sons ne s’exécutent pas dans la visionneuse interne de KoolMoves. 
 
Si un son dure plus longtemps que l’animation et si celle-ci est jouée en boucle, le 
son de la première boucle continuera de s’exécuter pendant la deuxième boucle 
jusqu'à ce que le son de la première boucle s’achève. Cet effet empire au fur et à 
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mesure que l’animation joue en boucle. Pour résoudre ce problème, ajoutez l'action 
Stop Sound à la dernière image clé. 
 
Si votre ficher audio est échantillonné à un taux autre que 5500, 11025, 22050, ou 
44100, il sera joué dans la visionneuse Flash à un taux voisin d’un des quatre cités 
ci-dessus. 
 
Une audio suivie de pointillés indique la durée d'un son dans la vue Action and 
Sound Overview et dans l’onglet Action and Sound de la vue Score / Timeline. 
Les événements qui recouvrent plusieurs trames occupent plusieurs dans la liste 
d'images clé. 
 
Voici une brève explication des actions sur les images clé [frame actions] : 
a) Go to Frame indique une image de destination (si l'image précédente ou l’image 
suivante est sélectionnée, ce peut être une image intermédiaire si c'est l'image 
contiguë) 
b) Play joue le film à partir de l'image courante 
c) Stop arrête le film à la l'image courante 
d) Stop Sound arrête tous les sons 
e) Load Movie charge un film (explications ci-dessous) 
f) Unload Movie décharge un film 
g) Set Dynamic Text positionne le contenu d’un objet texte dynamique 
h) Load Dynamic Text charge une texte dans un objet texte dynamique à partir 
d'un fichier .txt (ce fichier doit commencer avec le nom de l’objet texte suivi du 
signe égal suivi du texte sans guillemets) 
i) FS Commands fournit une méthode générale pour que Flash envoie un message 
au programme qui héberge la visionneuse Flash 
j) Javascript comme son nom l’indique… insère un script Javascript 
 
Il est important de noter qu'une action Stop dans la première image clé est souvent 
ignorée par la visionneuse Flash. La solution est de créer une première image 
factice.  
 
Pour une visualisation sur Internet, l’URL de l’animation chargée peut être une Url 
absolue ou relative, mais, pour les essais, toutes les animations doivent être placées 
dans le même dossier sans indication d'unité de disques ou de dossier dans leurs 
noms. En visionnant un film en utilisant la visionneuse du navigateur tous les 
fichiers HTML et SWF référencés par une action Get Movie ou Load Movie 
DOIVENT être dans le même répertoire que le fichier .FUN pour que ces boutons 
d’action accèdent à ces fichiers ; autre possibilité, positionner le dossier d’exécution 
des animations dans Preference. 
 
Pour enchaîner les animations l’une à l’autre utilisez Load Movie. Créez une 
animation initiale qui charge les autres animations et puis boucle - assurez-vous 
que vous ne bouclez pas l'action de chargement [Load Movie]. Chargez votre film 
principal dans la couche de niveau 2 et votre arrière plan dans le niveau 1. Exécutez 
l’animation jusqu’à la fin puis placez une commande de chargement [Load Movie] 
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dans le niveau 2. Cela chargera la nouvelle animation dans ce niveau. Créez alors 
des images additionelles et rebouclez. 

 
Load Movie charge une animation sans interrompre l’animation précédante. À moins 
que vous n’incluiez dans la nouvelle animation une forme placée sous toutes les 
autres formes qui égale ou excède la taille de l'image du film et qui soit remplie 
avec une couleur opaque ou une image mosaïque, vous verrez la première  
animation sous la nouvelle animation. La taille et la vitesse du film sont 
positionnées par le film au niveau 0. 
 
Aucune des actions de trame [frame action] ne fonctionne dans la visionneuse 
interne de KoolMoves. 



Associer des sons à un bouton 

Aide KoolMoves – Traduction jean.fruitet@free.fr - 33/171 

Associer des sons à un bouton 
Des sons (format MP3 ou .wav PCM) 
peuvent être associés à un bouton 
d’une animation, déclenchés quand la 
souris survole celui-ci ou qu’il est 
enfoncé. Il suffit de saisir le nom d’un 
fichier audio pour chaque tat du bouton 
dans la boîte des propriétés de forme. 
Rappelons que sur la soxantaine de 
formats de fichiers Wav KoolMoves ne 
supporte que le format PCM.  
L’état « over » d’un bouton est associé 
aux évènements de souris survol [roll 
over], fin du survol [roll out], tirer [drag 
over] et fin de tirer [drag out]. L’état 
enfoncé d’un bouton est associé aux 
événement souris cliquer [press] et 
relâcher [release]. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Si vous utilisez le même son à plusieurs reprises dans une animation il sera 
référencé autant de fois dans l’animation Flash ™ mais enregistré une seule fois 
dans le fichier .swf. 
 
Les fichiers audio tendent à être très lourds et rendent le fichier exporté SWF 
énorme. Pour conserver une taille raisonable aux fichiers audio, procédez ainsi : 
dans un éditeur audio convertissez les sons de stéréo en mono et choisissez un taux 
d'échantillonnage qui conserve la qualité dont vous avez besoin. Raccourcir la piste 
audio peut aussi être utile. 
 
Les sons ne s’exécutent pas dans la visionneuse interne de KoolMoves. 
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Si un son dure plus longtemps que l’animation et si celle-ci est jouée en boucle, le 
son de la première boucle continuera de s’exécuter pendant la deuxième boucle 
jusqu'à ce que le son de la première boucle s’achève. Cet effet empire au fur et à 
mesure que l’animation joue en boucle. Pour résoudre ce problème, ajoutez l'action 
Stop Sound à la dernière image clé. 
 
Si votre ficher audio est échantillonné à un taux autre que 5500, 11025, 22050, ou 
44100, il sera joué dans la visionneuse Flash à un taux voisin d’un des quatre cités 
ci-dessus. 
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Commande d’action FS 
Les commandes d’action FS fournissent un moyen générique de communication 
entre la visionneuse Flash et le programme qui l’héberge. C’est une fonctionnalité 
avancée qui n’est pas à la portée de l’utilisateur moyen. 
 
Ces commandes ne sont guère fiables car de nombreux navigateurs les ignorent. Il 
est préférable de passer l’information de fichier SWF au navigateur avec un scrip 
Javascript. De m^me il vaut mieux utiliser des scripts d’action pour disposer 
d’intéractivité. Il y a cependant quelques cas où ce n’est pas le cas. 
 
Dans un navigateur Web, la commande FS appelle la fonction javascript Commande 
FS. Dans Director, la commande FS envoie un message interprété comme un 
événement par Lingo. Dans Authorware, la commande FS  envoie des commandes à 
l’environnement de script. En Visual Basic et Visual C++, elle envoie un événement 
VB avec deux chaînes [string]. 
 
Voici l’adresse d’un tutorial indiuant comment utiliser des commande FS dpuis 
Flash : http://www.flashkit.com/cgi-bin/tutorials/jump.cgi?ID=584 . 
 
Le mécanisme de commande FS a été développé dans Flash pour deux raisons. 
Pour permettre aux fichiers SWF de communiquer avec Live Connect et Active X. 
Quand tt [ ?] a été implanté Internet Explorer ne supportait pas Javascript. Les 
commandes étaient des URL. Les commandes FS était le seul moyen de passer des 
informations à IE 3.0 ou moins. 
 
Les premières versions de Flash, Flash 3 ou moins, n’avaient qu’un environnement 
de script très limité. Pour utiliser un script il fallait passer par des commandes FS et 
des méthodes de la visionneuse Flash [Flash Player Methods]. Et comme les auteurs 
des Notes techniques de Flash ont écrit qu’il fallait passer par des commandes FS 
pour communiquer avec Flash, tous les auteurs de livres sur Flash qui ont suivi ont 
répété cette histoire, qui est fausse. La plupart des tutorials des commandes FS sur 
le net confondent celles-ci avec des méthodes de la visionneuse Flash. 
 
Les commandes FS passent une variable et un argument au langage de script natif. 
A l’exception des fichiers de diaporama [projector files] qui disposent de quelques 
commandes limitées en interne, vous devez rédiger le script vous-même.Et vous 
devez savoir qu’il n’y a aucun support Active X pour le navigateur IE du Mac, ni pour 
Netscape, Mozilla ou la plupart des navigateurs en Open source. M^me Linux a 
abandonné Live Connect. Par conséquent l’utilisation des commandes FS pour des 
pages Web est problématique. 
 
L’usage le plus fréquent d’une commande FS concerne l’utilisation de diaporamas 
[projectors]. Ces commandes sont appelées très simplement en utilisant les mots 
de commande ci-dessous dans la boîte de dialogue FS Command, avec la liste 
d’arguments dans la boîte d’arguments. Il faut commencer la commande avec la 
chaîne « FS Command: ». 
Arguments de la commande : 

http://www.flashkit.com/cgi-bin/tutorials/jump.cgi?ID=584
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Quit None 
FullScreen True/False 
AllowScale True/False 
ShowMenu True/False 
Exec Path of EXE you want launched. 
Save File Name 
Quit 
 
Explications : 
Quit : Coupe  la visionneuse 
FullScreen : Rend votre projecteur plein écran si positionné à ‘true’ et normal sinon. 
AllowScale : Autorise vos figures graphiques à changer d’échelle ou pas avec le 
diaporama. 
ShowMenu : Affiche le menu du diaporama ou l’élimine. 
Exec : lance tout fichier EXE ; sur Mac lance un applescript. Vous devez fournir le 
chemin de l’exécutable. 
Save : disponible uniquement dans la visionneuse autonome Flash 5 et pouvant être 
supprimée à tout moment sans avertissement. Sauvegarde de toutes les variables 
dans un fichier .txt dans le dossier racine. 
 
De nombreux programme d’amélioration de diaporamas comme Flash Tools, SWF 
Studio, Swish Canvas, Flashants FMProjector ont des commandes FS maison 
intégrées. Lisez la documentation soigneusement avant d’implanteer une de ces 
commandes spécialisées. Une bonne raison de faire appel à ces programmes pour 
communiquer avec des pages Web, en dehors du fait que les navigateurs ne 
supportent pas les commandes FS, c’est que les commandes FS ne font pas cliquer 
[to click] le navigateur quand elles osnt émisent, comme le font les commandes 
Javascript [ ?]. 
 
Pour utiliser des commandes FS vous devez intégrer ces lignes à votre page web : 
 
<script=;"javascript;"> function navmovie_DoFSCommand(command, args) 
{ 
if ( command == "init" ) { 
var buttons = parent.InternetExplorer ? window.navmovie : 
window.document.navmovie; if (buttons != null ) { 
buttons.GotoFrame(parent.targetFrame); 
// This function ensures that the navigation bar movie is set to the proper 
// keyframe when it initially loads. The argument init is the name you use 
// as the command paramter for the action attached to the first keyframe  
// in the navigation bar movie. 
// Cette fonction assure que la barre de navigation de l’animation est positionnées  
// sur l’image clé correcte au chargement. L’argument « init » est le nom  
// que vous utilisez comme paramètre de la commande pour l’action  
// attachée à cette première image. 
 
} } // Hook for Internet Explorer 
if (navigator.appName && 
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navigator.appName.indexOf("Microsoft") != -1 && 
navigator.userAgent.indexOf("Windows") != -1 && 
navigator.userAgent.indexOf("Windows 3.1") == -1) { 
document.write('<SCRIPT LANGUAGE=VBScript>'); 
document.write('on error resume next '); 
document.write('Sub fscommand_FSCommand(ByVal command, ByVal args) 
'); 
document.write(' call fscommand_DoFSCommand(command, args) '); 
document.write('end sub '); 
document.write('</SCRIPT> '); 
} 
//--></SCRIPT> 
</SCRIPT> 
 
Remarquez que vous devez inclure du VB dans votre page pour capturer les 
commandes FS par Active X. Voici une information importante. Une commande FS 
quand elle est adressée à un programme consiste seulement en une variable et une 
valeur. Vous devez bâtir en javasscripts l’interface adaptée [proper handler] à votre 
commande et à ses arguments. 
 
Passons maintenant à l’usage probablement le plus utile de commandes FS : pour 
les programme maison qui font de Flash leur interface comme Authorware et VB 
projects. 
 
C’est assuré par la méthode Active X dde Flash : 
 
FSCommand(command, args) 
 
Générée qund une commande FS est exécutée dans l’animation avec une URL et 
que cette URL commence par FSCommand :. Utilisez-la pour programmer une 
réponse à une action de trame [frame action] ou à une action de bouton dans une 
animation Flash. 
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Liens et boutons 
Pour placer une forme ou un texte 
dans un bouton sélectionnez « yes » 
pour « Is a Button » dans la fenêtre 
des propriétés. Un bouton peut 
appeler un lien vers une autre page 
web mais il peut faire bien autre 
chose. Vous pouvez modifer 
l’apparence du bouton en fonction 
des différents événements souris. Et 
vous pouvez programmer des 
actions comme aller à une autre page web quand le bouton est relâché (action 
appellée GetURL). 
 
Un bouton peut changer d’apparence dynamiquement dans une visionneuse Flash 
on une page web,reflétant que la souris est hors du bouton, sur le bouton (i.e. effet 
de survol), ou que le bouton est enfoncé. Pour réaliser ces effets sélectionnez 
« yes » pour la propriété « Has States ». A la sélection de « yes » la boîte de 
dialogue change, trois boutons, Up/Over/Down sont ajoutés dans la partie haute de 
la boîte. Chaque état peut avoir son propre son, forme, couleur, etc. Objet de 
confusion : les actions pour le bouton  -- ce que le bouton fait comme par exemple 
changer de page web – ne sont ajoutées qu’à la page de la propriété d’état Up 
(l’état du bouton quand celui-ci n’est ni survolé par la souris ni enfoncé). Et parce 
que l’interface est WYSIWYG (tel vu tel fait) le bouton apparaît dans l’animation 
pour chaque trame où il apparaît dans l’environnement d’édition. Autrement dit si 
un bouton manque dans une trame il manquera dans l’animation pour cette trame 
là. 
 
Si vous enfoncez pour la première fois le 
bouton Over (correspondant aux différents 
événements souris de survol [roll over, roll 
out, drag over et drag out], on vous 
demande si vous voulez créer l’état over à 
partir d’une version déjà dessinée ou si 
vous voulez repartir de zéro. Si vous ne 
faites que modifier la couleur de l’état, 
vous sélectionnerez « copy the up state » 
et éditerez la couleur pour la faire 
correspondre à l’état Over.  
 

 
 
 
 
Quand le bouton Over est pressé, vous pouvez modifier ses 
propriétés dans l’état Over ou éditer la forme correespondant à 
celui-ci. Une image atténuée de la forme correspondant à l’état 
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Up est affichée sous la forme d’état Over pour vous aider à les aligner. Si vous 
voulez qu’un son soit joué quand la souris survole le bouton Over, ajoutez le son à 
la page de propriétés de celui-ci. Si vous voulez que le son soit joué quand la souris 
est cliquée ou relâchée sur le bouton, ajoutez le son à la page de propriété de l’état 
Down. 
 

En cliquant sur le bouton des propriétés 
d’action du bouton de l’état Up, vous  
pouvez assignez et éditer les actions 
associées à ce bouton qui peuvent être 
déclenchées par différents évènements 
souris.  
 
 
 
 
 
 
 
 
 
 
 

 
Le bouton + vous présente les différentes 
comportements de bouton (nous en 
ajouterons d’autres bientôt), pour la 
plupart explicites. Chacun peut répondre à 
un ou plusieurs évènements souris. 
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Sélectionner Get URL 
affiche un menu pop-up. 
On peut sélectionner quels 
événement souris activent 
l’action Get URL. L’URL 
appelée doit être 
renseignée. L’état Over 
d’un bouton est activé pour 
les évènements de souris 
de survol ; l’état Down 
d’un bouton est activé pour 
les évènements de souris 
cliquer, relâcher et relâcher 
en dehors de la zone 
[press, release, et release 
outside]. 
 

En pressant OK le comportement 
est ajouté à la liste de ceux qui 
sont associés au bouton. Tout 
comportement peut être édité ou 
affichée en détail par un double-
clic ou en passant par le bouton 
des propriétés (le second depuis 
la gauche en tête du pop-up). 
 
 
 
 
 
 
 
 

 
 
Si en plus d’envoyer vers l’URL quand on relâche la souris sur le bouton on veut 
qu’un effet de survol s’affiche on ajoute un deuxième comportement [action], un 
effet de souris [Mouse Effect], à la liste des comportements et on sélectionne Roll 
Over comme effet déclencheur d’un événement souris. L’action Mouse Effect est 
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spéciale en ce sens qu’elle contrôle l’aspect du bouton sans activer aucun 
comportement pour celui-ci. 

 
En pressant OK on affiche 
l’ensemble des comportements 
associés au bouton. 
 
 
 
 
 
 
 
 

 
 
Voici un bref exposé des autres comportements de boutons : 
Go to Frame spécifie l’image cible (si une image précédente ou suivante est 
sélectionnée, ce peut être une trame intermédiaire si c’est l’image contiguë). 
Play joue l’animation 
Stop arrête l’animation 
Stop Sounds fait silence 
Load Movie charge un animation (voir ci-dessous) 
Unload Movie décharge une animation 
Les actions Print et Print Bimap fournissent la possibilité d’imprimer les images clé 
Set Dynamic Texte positionne le contenu texte d’un objet texte dynamique 
Load Dynamic Text charge le texte dans un objet texte dynamique à partir d’un 
fichier .txt (le fichier commence avec le nom de l’objet texte suivi d’un signe égal 
suivi par le contenu du texte sans guillemets. 
Send Data Form récupère le contenu textuel d’un objet texte dynamique et l’envoie 
à une URL 
FS Command fournit une méthode générique de communication entre Flash et le 
programme hébergeant la visionneuse Flash 
 
Pour une utilisation sur le Web l’URL de l’animation chargée peut être une URL 
absolue ou une URL relative. Mais pour faire des tests toutes les animations doivent 
se trouver dans le même dossier sans aucune spécification de dossier ou de 
partition disque dans le nom du fichier de l’animation. De même il ne faut pas 
d’espace dans le nom du fichier car cela pose des problèmes au navigateur 
Netscape. La chaîne « http:// » ne doit pas être placée dans l’URL de l’animation à 
charger car cela pose aussi des problèmes à Netscape. Quand on teste une 
animation avec Play in Browser, tous les fichiers HTML ou SWF référencés par les 
actions Get URL ou par Load Movie DOIVENT être placés dans le même dossier que 
le fichier .fun de KoolMoves affin que ces comportements de boutons puissent 
accéder à ces fichiers ; l’alternative est de positionner la variable « directory » 
[répertoire / dossier] dans File / Preferences. Load Movies charge une animation 
sans refermer l’animation précédente. Tous les niveaux supérieurs ont des arrières 
plans transparents ce qui permet de visionner les couches inférieures. A moins 

http://�
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d’inclure dans l’animation chargée une forme opaque ou remplie avec une image 
bitmap d’une taille égale à la taille de la fenêtre d’animation [la taille d’une image 
clé] et placée en dessous de toutes les autres formes, vous verrez la première 
animation s’exécuter sous la nouvelle… La couleur d’arrière plan, la taille et la 
vitesse d’exécution d’une animation sont positionnées au niveau 0. Aucune des 
actions liées aux boutons ne fonctionne dans la visionneuse interne de KoolMoves. 
 
Pour enchaîner les animations les unes à la suite des autres utilisez LoadMovie. 
Créez une animation de base qui charge toutes les autres et boucle. – en vous 
assurant de ne pas inclure la commande de chargement dans la boucle ! Chargez 
votre animation principale dans le niveau 2 et votre arrière plan dans le niveau 1. 
Exécutez l’animation jusqu’au bout et placez une commande Load Movie dans le 
niveau 2. Cela chargera la nouvelle animation dans ce niveau. Ajoutez alors de 
nouvelles trames et rebouclez. 
 
Les comportements d’un bouton ne peuvent changer de trame en trame. Si vous 
voulez modifier un comportement d’une trame à l’autre, copiez et collez le bouton 
au même endroit de la seconde trame. Ceci crée un bouton qui ressemblera au 
bouton de la trame précédente mais pour lequel vous pourrez modifier les 
comportements. 

Symboles 
Une des méthodes principales pour créer des animations Flash ™ légères est de 
transformer autant de formes que possible en symboles. Un symbole est une forme 
qui peut être partagée par d’autres formes (appelées instances du symbole). Si 
vous déplacez un point d’une instance il sera déplacé dans toutes les instances de 
l’animation (KoolMoves vous demandera confirmation). Si vous modifiez le dégradé 
d’une instance, les dégradés de toutes les autres seront aussi changés. Et ainsi de 
suite. L’exception à la règle porte sur la couleur intérieure, la position, l’échelle et 
l’orientation de la forme. Ces paramètres ne changent que pour l’instance désignée 
et pas pour les autres. Ce qui est dicté par le format de fichier Flash. 
 
Pour des motifs de simplicité KoolMoves traite toutes les formes texte comme des 
symboles. 
 
Si vous avez des formes qui apparaissent plus d’une fois dans une image unique ou 
dans de multiples images, il est envisageable de transformer ces formes en 
symboles si vous n’avez pas à déplacer des points individuels d’une trame à l’autre… 
Dans les dessins animés il y a de nombreux cas où on voudra déplacer des points 
d’une image à l’autre, par exemple pour animer les mouvements d’une bouche qui 
parle, pour agiter une main, etc. Ces formes ne sont donc pas de bonnes candidates 
pour devenir des symboles. Si la forme est stationnaire et ne passe par aucune 
transformation durant toute l’animation, il n’est pas non plus utile d’en faire un 
symbole (KoolMoves prend directement en compte cette situation). Dans une 
version ultérieure nous fourniront une méthode pour convertir de façon optimale les 
formes en symboles quand la conception de l’animation sera achevée. Il ne sera pas 
nécessaire alors de réfléchir à ces optimisations en cours de création de l’animation. 
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Pour transformer une forme en 
symbole sélectionnez Yes pour la 
propriété Symbol. Cela doit être 
fait immédiatement après avoir 
créé la forme et avant de la 
recopier dans l’image même ou 
dans une autre image. Notez que 
les points de la forme ont une 
apparence différente pour 
indiquer que ces points sont 
potenntiellement partagés par 
d’autres formes. L’instance du 
symbole est éditée comme tout 
autre forme. Si une modification 
affecte d’autres instances, vous 
en serez averti. 
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Evènements souris 
 
Il y a sept évènements souris auxquels les boutons Flash peuvent répondre :  
Press [Press] : un bouton de la souris est cliqué sur un bouton Flash 
Relâché [Release] : ce bouton souris est relâchée après qu’un bouton Flash ait été 
cliqué 
Relâché hors zone [Release Outside] : la souris est relâchée en dehors du bouton 
Flash après que celui-ci ait été cliqué 
Survol [Roll Over] : le pointeur souris se déplace au dessus d’un bouton Flash 
Survol sortant [Roll Out] : le pointeur souris sort d’un bouton Flash 
Survol cliqué [Drag Over] : un bouton souris est maintenu cliqué sur un bouton 
Flash ; sans que le bouton de la souris soit relâché le pointeur souris est déplacé sur 
le bouton Flash 
Suvol cliqué sortant [Drag Out] : le pointeur souris est tiré hors d’un bouton flash 
alors qu’un bouton souris est enfoncé. 
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Charger une animation 
Load Movie charge un fichier d’animation SWF dans la visionneuse Flash. Cette 
commande peut servir à enchaîner plusieurs fichiers SWF. Le projet étant divisé en 
plusieurs animations plus courtes, les fichiers SWF sont chacun moins lourds, et se 
chaargent donc plus vite en mémoire. Cela permet aussi de s’affranchir de la taille 
maximale d’une animation Flash. 
 
Flash peut jouer simultanément plusieurs timelines. Chaque timeline est assignée à 
un niveau (une couche). La timeline principale est au niveau 0. Le niveau 0 décide 
de la vitesse de défilement des images, de la couleur d’arrière plan et de la taille de 
la fenêtre image pour toutes les autres animations chargées. Les timelines 
additionnelles sont empilées dans les niveaux d’ordre supérieur et affichés dans 
l’ordre inverse de chargement (la dernière chargée est en avant plan, la première 
en arrière plan). La commande Load Movie doit être passée avec un numéro de 
niveau pour définir dans quelle timeline le fichier SWF sera chargé. Si on ne charge 
qu’une animation, n’importe quel niveau supérieur ou égal à 1 convient. 
 
Une animation peut aussi être chargée dans le niveau 0. Cela remplace le contenu 
de la timeline principale par l’animation chargée. C’est un moyen efficace de lier 
plusieurs fichiers SWF pour réaliser un diaporama permanent. 
 
Si l’animation est chargée dans un niveau donné, elle se place par rapport au coin 
supérieur gauche de l’animation qui l’a chargée. 
 
L’utilisation de chemins de fichiers relatifs avec Load Movie peut conduire à des 
confusions. Comme toute timeline peut appeler Load Movie, quel est le chemin 
relatif de chargement ? Est-ce par rapport à la timeline du niveau 0 ou par rapport à 
celle qui a appelé Load Movie ? La réponse est claire : les fichiers appelés par Load 
Movie sont toujours relatifs à la timeline qui les a chargés. 
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Les commandes d’action Print et Print Bitmap 
Les commandes d’action Print et Print Bitmap donnent la possibilité d’imprimer 
les images clé depuis l’animation elle-même. Les images clé étiquetées avec #P 
(voir le chapitre Etiquetage des images [Frame Labels]) seront imprimées ; sinon 
elles le seront toutes. 
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Etiquetage des images clé 
Pour étiqueter une image clé, sélectionnez-la à la souris dans la liste des images 
[list of frames]. Cliquez à nouveau ans l’image pour avoir un curseur dans le champ 
d’étiquette. Saisissez la nouvelle étiquette. 
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Exemple d’effet de survol [Roll-Over] 
Voici un tutorial élémentaire qui décrit les étapes de création 
d’un simple effet de survol [roll-over] à base d’un bouton 
ovale rempli en dégradé.  

L’ovale reçoit un 
remplissage en dégradé 
et sa bordure une 
épaisseur de zéro. 
 
 

Puis l’ovale est transformé en 
symbole en sélectionnant ‘yes’ 
pour l’item « Is a Symbol » 
(une étape indispensable avant 
de le transformer en bouton) et 
« Is a Button » reçoit la valeur 
‘yes’. Pour produire l’effet de 
survol ce bouton doit avoir un 
état bouton (son apparence 
quand le pointeur de la souris le 
survole) aussi l’item « Has 
States » reçoit aussi la valeur 
‘yes’. Enfin le comportement du 
bouton [button’s actions] lors 
d’évènements souris est défini.  
 
Pour rendre un simple effet de 
survol sans autre 

comportement le label 
Mouse Event est sélectionné. 
Si nous voulons que le 
bouton réagisse quand le 
bouton de souris est pressé, 
nous sélectionnons Get URL, 
Go To Frame ou n’importe 
laquelle des commandes 
souhaitées. Mais pour un 
simple effet de survo il suffit 
de sélectionner Mouse Event. 
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On coche donc la case Roll Over.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Si un état enfoncé est aussi défini on peut aussi bien cocher Release ou Press. 
 

Après avoir sélectionné 
OK on revient au menu 
pop-up précédent et on 
voit le comportement 
qui vient d’être défini 
dans la liste Button 
Actions. En double- 
cliquant sur lui on peut 
l’éditer. En sélectionnant 
le ‘+’ on peut ajouter 
d’autres 
comportements. 
 
On est maintenant prêt 
à définir l’état 
« recouvert » du bouton 
(quand le pointeur de la 
souris est dessus). 
Sélectionnons Over en 
tête du menu pop-up 
des propriétés. Parce 
que l’état « recouvert » 
n’a pas encore été défini 
il est demandé s’il faut 
le créer à partir d’un 
autre état existant ou si 
on veut le dessiner soi-
même. Sélectionnons de 
le recopier à partir de 
l’état « haut » [up] (son 
apparence quand le 
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pointeur souris ne le recouvre pas) qui est affiché à gauche en transparence pour 
permettre un positionnement correct. Si on avait choisi de le dessiner soi-même il 
aurait été possible de tracer librement n’importe quelle forme, texte ou non texte. 
Si l’état « recouvert » [Over state] est placé avec un léger décalage relativement à 
l’état « haut » [Up state] le bouton vibre un peu en cours d’animation, traduisant ce 
léger décalage. 

 
Pour rendre l’état recouvert différent de l’état haut, modifions le dégradé de couleur 
de l’état recouvert [over state]. Cliquons le bouton Up en haut du menu des 
propriétés pour sortir de l’état Over. Nous sommes prêts à tester ll’effet de survol 
qu’on vient de créer. 
 
Sélectionnons Play dans la visionneuse indépendante. Avec 
la souris en dehors du bouton on voit celui-ci affiché dans 
le dégradé associé à l’état haut [Up].  
 
 

Avec la souris sur le bouton c’est 
la couleur de dégradé associée à 
l’état recouvert [Over]. Le test est un succès ! 
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Masquage 
Le masquage est une technique très puissante. Ci-après l’illustration d’une 
animation simple basée sur des lettres révélées de gauche à droite avec un effet de 
dégradé par un texte masqué. 

 
On comence par créer une forme ciculaire sans bordure et remplie avec un dégradé. 
Par dessus on place une forme texte. Le texte est le masque. Pensez-y comme un 
couteau à gâteau. Le masque découpe les contours de ce qu’il recouvre jusqu’à la 
limite de sa profondeur de masquage, en l’occurrence 1. La couleur et le 
remplissage du masque sont immatériels. Le masque lui-même est invisible quand 
l’animation s’exécute. Dans l’environnement d’édition le masque est visible par 
défaut. 

 
On transforme une forme en masque dans le menu des propriétés. La profondeur de 
masquage y est aussi attribuée. A l’exception des boutons, tout peut être 
transformé en masque. 

 
Dans la première image clé la forme emplie en dégradé est placée à la gauche du 
texte. L’image est copiée et la forme en dégradé déplacée à droite du texte. 
Pendant l’animation le dégradé va balayer le texte en révélant les lettres. 

 
Voici maintenant le dégradé sous la partie centrale du texte (on a alors trois images 
clé). 
 



Masquage 

Aide KoolMoves – Traduction jean.fruitet@free.fr - 52/171 

Pour voir l’effet du masquage pressez Ctrl+M. Voici à quoi 
ressemble l’animation quand cette image est jouée. Ctrl+M à 
nouveau supprime l’effet de masquage et rend le masque visible. 
 

La boîte des formes [Shapes] identifie les formes de 
masquage et les formes masquées avec deux icônes 
différentes. Le masque est toujours au-dessus de la 
forme qu’il masque. 
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Editer et visionner les images clé 

 
Pour étendre une animation, typiquement vous copiez la trame courante en fin 
d’animation. Dans la nouvelle trame vous développez l’animation en modifiant la 
position de formes et des couleurs, déplaçant des points de contrôle, ajoutant des 
formes, etc.  

 
 
Vous pouvez afficher la liste des images clé avec Views 
> List of Key Frames. Cette liste peut être utilisée pour 
naviguer, renommer, éditer les images clé (couper, 
copier, coller, modifier l’ordre des trames). Pour changer 
la position d’une trame ou de plusieurs dans l’animation 
ou pour couper / copier / coller des trames, faites votre 
sélection dans la liste des trames et utilisez les 
commandes d’édition à droite. Pour les sélections 
multiples utilisez la touche Shift. Coller place les trames 
copieée ou coupées avant la trame courante,. Pour 
renommer une trame sélectionnez  la dans la liste et 
cliquez une seconde fois pour avoir le curseur de saisie. 
Entrez le nom dsié. La fenêtre peut être 
redimensionnées en étirant les marques de dimension 
en bas à droite. 
 
Le nombre dans la boîte de sélection est le nombre de 
trames intermédiaires [tween frames] entre l’image clé 
courante et la suivante. Ce nombre est en général 
supérieur à zéro pour que KoolMoves génère des 
transitions douces (appelée anamorphoses) entre les 
images clé. Ajouter des trames intermédiaires est la 
plupart du temps plus économique que d’ajouter des 
images clé en terme de taille du fichier d’animation 

Flash ™ exporté, en particulier pour les formes avec de nombreux points de 
contrôle. Ajouter des trames intermédiaires vous permet aussi de contrôler la 
vitesse d’animation – plus il y a de trames intermédiaires, plus lente est la transition 
vers l’image clé suivante. 
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 KoolMoves dispose d’une 
visionneuse interne qui joue les animations en boucle. Vous pouvez aussi parcourir 
l’animation pas à pas ou la voir dans une page web vide ou dans une visionneuse 
Flash ™ qu’on peut télécharger sur le site de Macromedia. 
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Image clé 
Une image clé est une image que vous créez vous-même. KoolMoves génère les 
images intermédiaires entre deux images clé. 
 
Lors de la création d’un dessin animé à la main, typiquement c’est le principal 
animateur qui crée les images clé et les assistants qui dessinent les images 
intermédiaires. Dans KoolMoves c’est le logiciel qui s’en charge. 
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Image / trame intermédiaire. 
 
Une image intermédiaire [tween] est une image générée automatiquement par 
KoolMoves et calculée à partir de la position et de la couleur des formes de deux 
images clé consécutives. Pour accélérer le mouvement entre deux images clé, 
assignez un nombre réduit d’images intermédiaires. Des effets dramatiques peuvent 
être obtenus avec un nombre nul de trames intermédiaires. Pour ralentir l’action ou 
pour rendre l’animation plus fluide, assignez un nombre plus important d’images 
intermédiaires.
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Inversion d’images 
Commencez par afficher la liste des images (List Frames sous la barre de menu 
Frames). Sélectionnez la fonction Reverse Frames sous la barre de menu Frames. 
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Remodelage 
Le mouvement est au cœur du procédé d’animation. Le mouvement est obtenu en 
déplaçant des objets (des formes) d’une image à l’autre. La modification des formes 
peut prendre de nombreuses aspects : déplacement globale d’une position à l’autre 
dans des images clé, déplacement ou transformation des points de contrôle associés 
à l forme, modification de la couleur ou de la bordure, ajout ou suppression de 
points. KoolMoves fournit de nombreux outils pour obtenir ces effets sans brider la 
créativité. 

 
Déplacer une forme ou un groupe de formes est 
simple. Choisissez la forme ou le groupe de formes 
avec l'outil de sélection de formes et glissez la 
souris. Pour plus de précision, vous pouvez 
employer les touches de déplacement du curseur. 
La combinaison de la touche shift et des touches 
curseur produit un déplacement de 10 pixels. 

 
Déplacer un point ou un groupe de points est également 
simple. Sélectionnez les points avec l'outil de sélection 
de points et glissez la souris. Pour plus de précision, 
employez les touches de déplacement du curseur. 
 
Les formes et les lignes courbes sont définies par des 
points de contrôle dans et hors la forme (indiqués par 
les cercles tiretés). Vous pouvez changer la forme de la courbe en déplaçant ces 
points.  

 
Pour ajouter un point à la 
bordure d'une forme 
utilisez l'outil d'insertion 
de points (que la forme 
ait une bordure ou pas ou 
si le remplissage est une 
couleur ou un image 
mosaïque).  
 

Vous obtenez un curseur qui 
indique quand vous pouvez 
ajouter un point.  
 
Voici à quoi il ressemble quand 
vous n'êtes pas sur une ligne 
de bordure.  
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Et à ceci quand vous êtes sur une bordure.  
 
 
 
 
 
 

Cliquez la souris et un point est ajouté. 
 
 
 
 
 
 
 

 
Sans lâcher la souris, vous pouvez glisser 
le point à une nouvelle position. 
 
 

Pour supprimer un point sur la 
bordure d'une forme utilisez 
l'outil d'effacement de point. 
 
 
 
 
 
 

Vous obtenez un curseur qui indique quand 
vous pouvez supprimer un point.  
 
Il ressemble à ceci quand vous n'êtes pas 
sur un point 
 
 
 
 
 

Et il ressemble à ceci quand vous êtes sur 
un point.  
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Cliquez la souris et le point est supprimé.  
 
 
 
 
 
 
 

 
 Pour changer la bordure d'une forme 
d'une ligne droite en ligne incurvée, 
utilisez l'outil d'ajout de courbe. 
 
 
 
 
 

Vous obtenez un curseur qui indique quand 
pouvez ajouter une courbe. Il ressemble à ceci 
quand vous n'êtes pas sur une ligne de bordure 
droite.  
 
 
 
 
 
 

 
 Et à ceci quand vous êtes sur une ligne de 
bordure droite. 
 
 
 
 
 
 
 
 

Cliquez la souris et une courbe est ajoutée.  
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 Sans lâcher la souris, vous pouvez glisser le 
point de contrôle de la courbe dans une 
nouvelle position. 
 
 
 
 
 
 
 
 

Pour redimensionner, tourner, renverser 
horizontalement ou verticalement, incliner, étirer 
ou créer une perspective sur un ou plusieurs 
formes ou sur un ou plusieurs points sélectionnés, 
utilisez un des outils de transformation.  
 
 
 
 
 

 
 La plupart des outils présentent un 
ensemble de poignées que vous pouvez 
glisser dans différentes directions pour 
obtenir l'effet voulu. Ci-contre, la souris 
glisse la poignée de changement de taille qui 
conserve les proportions en x et y. 
 
 
 
 

L'outil de rotation vous laisse définir le centre 
de la rotation indiqué par un petit carré sur 
une croix. Glissez ce carré pour placer le 
centre de la rotation.  
 
 

 
 
 
 
 Un autre outil incline [slant] la sélection.  
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Tous les outils (flip, squish, squash, stretch etc.) transforment aussi les textes 
excepté l’incliné slant et perspective. 
 
Squash est employé en animation pour donner l'effet de pesanteur sur un objet. 
Stretch employé pour un mouvement opposé à la pesanteur. Un bon exemple 
serait le rebondissement d'une boule de caoutchouc. Quand la boule touche le sol, 
sa forme passe de cercle à ellipse et quand elle rebondit en l'air sa forme se dilate 
légèrement. Stretch et squash peuvent être créés en utilisant l'outil Squash dans la 
section d'outils d'effets. 
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Animations agrafées [Movie clips] 
Les animations agrafées [Movie clips] sont un dispositif avancé de KoolMoves. C'est 
une animation dans une animation avec ses propres images clé. Les clips sont 
importants parce que leurs propriétés peuvent être dynamiquement changées par 
l'intermédiaire des scripts d'action. 
 
Il y a deux façon de céer un clip : appuyer sur le bouton New movie clip (sous la 
flèche de sélection dans la barre d'outils) ou cliquer le bouton de conversion les 
formes en clip (onglet New Movie clip). Des commandes sont également placées 
sous Shapes dans la barre de menu principale. 
 
La portée de conversion d'une forme en clip – cette seule image, toutes les images, 
etc. -- détermine la composition de l'animation agrafée. Si vous choisissez un 
certain nombre de formes dans l'image courante et sélectionnez toutes les images 
pour la portée de la conversion, toutes ces formes seront converties en clip dans 
toutes les images quelles qu'elles soient. 
 
Un symbole de sélection de clip est semblable à un symbole ordinaire excepté 
l'ombrage gris bleu des coins. Double-cliquer sur un symbole de clip affiche une 
boîte des propriétés. Ses propriétés sont 1) des effets de transition et 2) des effets 
"onClipEvents" basé sur des scripts d'action. Pour faire apparaître la composition 
clip et accéder à sa timeline, appuyez sur le bouton Frames en haut du menu des 
propriétés. 
 
Dans ce menu des propriétés vous pouvez créer et assigner des valeurs aux 
paramètres du clip. Ces paramètres sont exportés dans le fichier SWF au dessus de 
la première image du clip. Les paramètres fournissent un biais pour que des clips  
réutilisables soient adaptés par l’utilisateur final.
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Squelettes 
Un squelette peut être attaché à n'importe quoi excepté les symboles. Si vous 
dessinez soouvent les formes  comme des symboles vous choisirez probablement de 
positionner à off cette option dans les préférences. La déclaration d’un squelette 
n'est disponible que dans le modèle d'interface Cartooning.  
 
La fonction squelette n'est souvent proposée que dans les logiciels d'animation de 
personnages coûteux. Elle permet au concepteur d'attacher un squelette à une 
figure. Des changements de position des parties de la figure peuvent être pilotés 
efficacement en manoeuvrant son squelette. Ce dispositif s'appelle en général 
« squelette » [Bones]. KoolMoves a un système de squelette primitif. 
 
 Pour attacher un 
squelette à cette 
figure simple 
indiquez dans la 
boîte de propriétés 
que cette figure a un 
squelette. Un 
squelette peut être 
attaché à une forme 
simple ou à un 
groupe de formes.  
Pour ajouter ou  
pour éditer le 
squelette, appuyez 
sur le bouton Bones 
en haut de la boîte 
de dialogue. 
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Comme pour éditer les états d'un bouton, un environnement pour éditer les 
squelettes est fourni. Une image atténuée de la forme est affichée, à laquelle vous 
allez attacher le squelette. L'outil de dessin du squelette se comporte comme l’outil 
de dessin dans la fenêtre d'édition principale.  
 
Vous dessinez le squelette en déplaçant le pointeur de 
la souris et en cliquant la souris à chaque point 
d’articulation.  
 

 
 
 
 
 
 
 
 
 
 Double-clic pour terminer le squelette. Quand 
vous relâchez la souris, toutes les articulations 
sont soulignées.  
 
 
 

Dessinez de même les autres membres du squelette.  
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Et voici le résultat quand tous les segments du 
squelette sont en place.  
 
 
 
 
 
 
 
 
 
 
 
 

Vous voudrez probablement faire partager 
certaines articulations par différents 
segments du squelette.  
 
Pour ce faire utilisez l'outil de groupement 
[Joint]. Cliquez cet outil et dessinez une 
boîte autour des articulations que vous 
voulez fusionner. Sous l'outil de 
regroupement il y a un outil de dégroupage 
[unjoin]. 

 
 Quand vous êtes fini l’édition du 
squelette, cliquez le bouton de 
retour au à l’édition des images 
clé. La figure ci-contre montre la 
forme avec son squelette 
nouvellement ajouté dans la 
fenêtre de dessin principale. Vous 
pouvez déplacer des articulations 
du squelette dans cette fenêtre 

en choisissant l'outil selection/déplacement des articulations. 
 
Voici qui illustre la sélection et le déplacement d’une 
articulation. Il y a beaucoup d’amélioration à apporter à 
notre outil de squelette surtout concernant l'interaction 
dynamique entre le squelette et le corps de la figure. 
 
Vous pouvez consulter l’articumation primaire et 
secondaire que le programme emploie pour le contrôle de 
chaque forme en cliquant sur View > View Associated 
Joints et en sélectionnant un point de la forme. Quelques 
points seulement sont contrôlés par une articulation 
unique. 
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Symbole 
 
Un symbole est une forme qui est dessinée une fois et réutilisée plusieurs fois dans 
une animation. Une des options des préférences est de dessiner les formes comme 
des symboles. Dessiner des formes comme symboles produit des fichiers SWF de 
moindre poids mais limite les possibilités de modifier les formes image par image. 
Ces limitations sont acceptables pour la plupart des concepteurs mais seraient 
inacceptables pour des réalisateurs de dessins animés par exemple. 
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Raccourcis clavier 
 
< Single step backwards Un pas en arrière 
> Single step forwards Un pas en avant 
Ctrl+A Select all shapes Sélection de toutes les formes 
Ctrl+Shift+A Unselect all shapes Déselection des formes 

sélectionnées 
Ctrl+B Add blank frame Ajout d’une image clé vide 
Ctrl+Shift+B Align bottoms Allignement bas 
Ctrl+C Copy shapes Copie d’une forme 
Ctrl+Alt+C  Center Centrer 
Ctrl+D  Dependencies Dépendances 
Ctrl+E  Sounds and actions Sons et comportement 
Ctrl+G  Group shapes Groupement des formes  
Ctrl+Shift+G  Ungroup shapes Dégroupage des formes 
Ctrl+H  Hide/unhide shapes Masquer / révler des formes 
Ctrl+Atl+H  Flip horizontally Inversion horizontale 
Ctrl+Shift+H  Align on horizontal centers Alignement horizntal 
Ctrl+I  Invert selection Sélection inverse 
Ctrl+K  List key frames Liste des images clé 
Ctrl+L  Last selection Sélection récente 
Ctrl+Shift+L  Align left Alignement à gauche 
Ctrl+M  Show masking Affiche les masques 
Ctrl+N  New file Nouveau fichier 
Ctrl+Alt+N  Numeric transform Transformation numérique 
Ctrl+O  Open file Ouverture de fichier 
Ctrl+Alt+P  Perspective Perspective 
Ctrl+Alt+Q  Squish Tordre 
Ctrl+Alt+R  Rotate Rotation 
Ctrl+Shift+R  Align right Alignement à droite 
Ctrl+S  Save file Sauvegarder un fichier 
Ctrl+Alt+S  Scale Redimensionner 
Ctrl+Alt+T  Slant Incliner 
Ctrl+Shift+T  Align tops Allignement haut 
Ctrl+V  Paste shapes Coller les formes 
Ctrl+Alt+V  Flip vertically Inversion verticale  
Ctrl+Shift+V  Align on vertical centers Alignement vertical 
Ctrl+Down  Send backward Repousser en second plan 
Alt+Down  Send backward popup [?] 
Ctrl+Shift+Down  Send to back Repousser en arrière plan 
Ctrl+End  Add frame to end Ajouter une image cé en fin 

d’animation 
Esc  Stop internal player Interrompre la visionneuse 

interne 
F1  Help Aide 
F10  List key frames Liste des images clé 
F2  Zoom in Loupe avant 
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F3  Zoom out Loupe arrière 
F4 No zoom Pas de loupe 
F5  Add point Ajout de point 
F6  Delete point Suppression de point 
F7  Move point Déplacement de point 
F9  List shapes Liste de formes 
Ctrl+Enter  Play in internal player Exécution dans la visionneuse 

interne 
Ctrl+Alt+Enter  Play in stand-alone player Exécution dans la visionneuse 

autonome 
Ctrl+Space  Play in browser Exécution dans un navigateur 
Ctrl+Up  Bring forward Placer en avant 
Alt+Up  Bring forward popup [?] 
Ctrl+Shift+Up  Bring to front Placer en premier plan 
Del  Delete shapes or points Suppression de points ou de 

formes 
Ctrl+X  Cut shapes Couper des formes 
Ctrl+Y  Redo Refaire 
Ctrl+Z  Undo Défaire 
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Trucs et astuces 
 
1. Pour choisir une forme ou des points sous une autre forme :  
Sélectionnez la forme sur le dessus et puis cliquez CTRL H  
pour masquer la forme, ce qui expose ce qui est dessous. Cliquez CTRL H encore 
pour annuler.  
 
2. Pour changer partout le remplissage d'une forme :  
Sélectionnez la forme avec la portée réglée à Toutes les Images.  
Toute modification de la forme est maintenant reflétée partout. Confirmation vous 
est demandée pour les changements globaux.  
 
3. Pour appeler une forme, sélectionner un nom de forme, ou sélectionner un disque 
dur pour récupérer une forme :  
Utilisez l'outil de liste de forme. Vous pouvez choisir différentes formes ou de 
multiple formes avec CTRL + Shift.  
 
4. Pour combiner des animations produites avec KoolMoves, Swish et Flash :  
Employez la commande Load Movie pour charger les films créés par d'autres outils 
ou importez les comme objets.  
 
5. Pour créer un pavage de fond :  
Créez un rectangle légèrement plus grand que la taille de la première image de 
l'animation et placez le en arrière-plan. Utilisez l'outil de remplissage pour remplir le 
rectangle de votre photo. Elle pavera le rectangle.  
Copiez le rectangle, allez à la deuxième image et utilisez Edit > Paste to end pour la 
recopier jusqu'à la fin de l'animation.  
 
6. Pour surmonter la limitation de taille des fichiers de Flash ™ :  
La visionneuse Flash fixe une limite à la taille du fichier swf principal. Si vous incluez 
un grand fichier sonore faites-en un fichier swf séparé et employez la commande 
d'action Load Movie pour le charger dans l'animation principale. De cette façon vous 
pouvez efficacement doubler la taille d'animation autorisée. Cette approche 
fonctionne en général pour créer de grandes animations. De plus découper le film 
en morceaux a pour conséquence un chargement plus rapide par Internet.  
 
7. Pour faire à un lien Internet vers un fichier swf tout entier sur un page Web :  
Créez une forme de la taille de l'écran de l'animation emplie avec la couleur de fond 
dans des toutes les images clé, placez-la en arrière plan et transformez-la en 
bouton ; autre solution : mettez une forme totalement transparente de la taille de 
l'image dans toutes les images clé et faites-en un bouton.  
8. Pour replacer l'image d'écran d'une animation dans la fenêtre d'édition principale 
:  
Employez Options > Reposition Movie Frame. 
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Incidents connus 
Sii une autre application volumineuse est exécutée en même temps que KoolMoves 
ce dernier peut se planter. Cela est dù à une disponibilité insuffisante de ressources 
système ou graphiques. 
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Aides dans différentes langues 
Un certain nombre de traductions (la plupart automatiques) de l’aide de KoolMoves 
sont disponibles dans les pages de support de KoolMoves. Et une ancienne version 
de l’aide en espagnol à http://www.geocities.com/powerxrv/Koolmoves/index.htm 

http://www.geocities.com/powerxrv/Koolmoves/index.htm
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Image / Ecran [Frame] 
Un écran (une image clé ) est une image de votre animation. Il y a deux types 
d’images : 
Celles que vous composez, appelées images clé [key frames] 
Celles que KoolMoves génère pour vous, appelée images intermédiaires ou jumelles 
[tweens] 
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Jumelage [Tweening] 
Le jumelage consiste à créer automatiquement une ou plusieurs images 
intermédiaires entre deux images clé… KoolMoves calcule automatiquement ces 
images pour vous. 
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Décalque d’image 
Vous pouvez afficher une image (au format .bmp) en arrière plan d’une image clé 
dans le but de la décalquer. Sélectionnez et affichez l’image à décalquer avec File > 
Trace Image > Display Image. L’image mosaïque est centrée sur l’écran. Utilisez 
l’un des outils de dessin pour la décalquer. Une fois le décalque achevé supprimez 
l’image de décalque avec File > Trace Image > Clear Image. Repositionnez la 
forme en la sélectionnant et en la glissant à la souris ou avec les flèches du curseur 
pour un positionnement très précis.
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Importer un dessin vectorisé [Clip Art] 
Un dessin vectorisé peut être importé dans KoolMoves en utilisant File > Import 
Vector Graphic. Cette fonction importe des fichiers .wmf, AutoCAD .dxf, .eps ou 
.emf et les convertit en formes KoolMoves avec des sommets (des points). Il y a 
plusieurs classes de dessins vectorisés, incluant les images mosaïques et les 
vecteurs. KooolMoves ne supporte que les objets de type vecteur dans lesquels 
chaque forme est définie par des sommets aux frontières et remplie avec une 
couleurs unique. 
 
Les dessins vectorisés ont souvent une grande densité de sommets si bine qu’on 
vous offre la possibilité de réduire le nombre de points en utilisant une interpolation 
curviligne automatiquement exécutée par KollMoves. Si des déails sont perdus ou si 
des lignes orphelines apparaissent augmentez le nombre de points d’interpolation à 
l’importation du fichier (i.e réduisez la diminution de sommets). 
 
Tous les objets de type clip art ne sont pas importés, par exemple les objets texte 
ne le sont pas pour le moment.  
 
Vous pouvez récupérer des fichiers de dessins vectorisés aux adresse Web 
suivantes : 
http://www.arttoday.com et http://www.clipartdownload.com. Vous pouvez en 
acheter à l’adresse http://www.eyewire.com/clipart/ . Corel puble de grandes 
collections de clip art. Vous pouvez en déssiner avec beaucoup d’applications de 
dessin vectorisé et les exporter dans un format compatible avec KoolMoves. 
 
Vous trouverez aussi un grande sélection de clip art gratuits créés avec KoolMoves à 
l’adresse www.Propellerhead-Graphix.com 
 
Pour éditer un dessin vectorisé, par exemple pour 
introduire un mouvement, enlacez la partie du clip 
art à éditer avec l’outil de sélection de points.  
 
Les points sélectionnés peuvent être translatés en 
utilisant les touches de curseur (les touches avec des 
flèches) ou déplacés avec la souris ; ils peuvent être 
retournés, inclinés, tordus, redimensionnés, ou mis en perspectives. Lire à ce 
propos le chapitre sur les techniques de remodelage. Typiquement vous remodelez 
ou changez la couleur d’un dessin vectorisé de l’image clé courante, ajoutez une 
nouvelle image, modifiez celle-ci, ajoutez encore une image clé, etc. pour créer 
votre animation. KoolMoves calcule l’anamorphose des formes entre les images clé 
pour générer une animation fluide. La vitesse de l’animation est positionnée par la 
vitesse globale et par le nombre de trames jumelles entre deux images clé. 

http://www.arttoday.com
http://www.clipartdownload.com
http://www.eyewire.com/clipart/
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Applications pour le dessin vectoriel 
Les logiciels suivants sont recommandés pour créer et enregistrer des dessins au 
format vecteur qui puissent être importés dans KoolMoves. Sun Star Office 
(http://www.openoffice.org), PhotoLine 32 (http://www.ciebv.com), Adobe 
Illustrator, Adobe Photoshop (versions récentes), et Adobe Streamline. Les formes 
créées avec Metafile Companion échouent la plupart du temps lors du chargement 
dans KoolMoves. Stardraw (freeware) et KTV convertissent les fichiers bitmap 
(mosaïques) en fichiers de vecteurs que l’on peut importer dans KoolMoves. 

http://www.openoffice.org
http://www.ciebv.com
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Sélection d’objets 
Les outils de sélection de formes et de points sont situés dans la partie supérieure 
de la palette d’outils. Ces outils sont fréquemment utilisés. Il permettent également 
de déplacer les formes et les points. Vous pouvez déplacer des formes ou des points 
précédemment sélectionnés en les glissant avec la souris (bouton gauche enfoncé). 
Pour choisir plusieurs formes maintenez la touche MAJ [SHIFT] enfoncée. 

 
 
Pour sélectionner une forme cliquez dessus quand 
l’outil de sélection est activé. Si la touche MAJ 
[Shift] est enfoncée vous l’ajoutez à celles déjà 
sélectionnées. 
 
 

 
Vous pouvez aussi sélectionner des formes en 
les englobant avec la souris et en gardant la 
touce MAJ [Shift] 
enfoncée. 
 
 
 
 
 

 
Troisième façon de sélectionner une ou plusieurs formes : 
appeler la liste de formes et les y sélectionner. Les formes 
sont nommées automatiquement lors de leur création mais 
vous pouvez modifier ce nom en l’éditant dans la liste de 
formes.  

 
On peut sélectionner un 
des points de contrôle 
d’une forme en cliquant 
dessus quand l'outil de 
sélection est activé.  
La zone de sélection d’un 
point peut être déplacée.  
 

 
En cliquant sur un point avec la touche MAJ 
[SHIFT] enfoncée, vous ajoutez celui-ci à la liste 
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des points déjà sélectionnés.  
 
Pour sélectionner plusieurs points englobez-les à la souris en gardant la touche MAJ 
enfoncée. Des points peuvent être associés à différentes formes.  
 
Il faut savoir que la sélection de points et de formes est un procédé très général. 
Vous pouvez sélectionner des formes multiples ou des points multiples. Les points 
multiples peuvent même être associés à différentes formes. Les formes et les points 
choisis peuvent être déplacés en maintenant le bouton gauche enfoncé et en 
glissant la souris ; on peut aussi utiliser les touches de déplacement du curseur. 

 
La sélection peut également s'appliquer à des images.  
 
Il y a quatre types de choix de forme et de point : (1) image courante 
seulement (le plus commun), (2) toutes les images de l’animation, 
(3) toutes les images, de l'image courante à la première image, et (4) 
toutes les images de l'image courante à la dernière image. 
 
Cette possibilité de sélectionner des images multiples est très 
puissante. Par exemple, si vous changez la couleur d'une forme dans 
l'image courante et que la forme est associée à d’autres images clé 
elles aussi sélectionnées, le changement de couleur sera appliqué à 
chacune des occurances de la forme de ces images. Pour empêcher 
les modifications par mégarde, une confirmation de l’extension des 
transformations aux autres images vous est demandée. La possibilité 
de transformer des formes sélectionnées dans plusieurs images, de 
réduire des points en excès dans l'image courante s'applique à la 
plupart des fonctions de KoolMoves -- transformation, remplissage de 
forme, déplacement, etc.  
 
Si vous vous voulez exclure quelques points de la sélection c’est 
possible. Une façon de procéder c’est de sélectionner la forme liée 
aux points que vous voulez exclure puis de sélectionner l'outil de 
sélection de point. Seuls les points liés à la forme précédemment 
choisie seront activés. Pour masquer des formes ou des points vous 

pouvez employer le menu Shapes > Hide Selection ou Points > Hide Selection. 
En choisissant Shapes> Selection Scope ou Points > Selection Area vous les 
affichez. Shapes > Invert Selection inverse le choix courant de forme ou de 
point. 
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Couleurs 
Formes et textes peuvent être 
coloriés avec des couleurs 
unies (avec ou sans 
transparence), avec un 
dégradé de couleur ou avec 
un pavage d’images 

mosaïques (par exemple des photographies). Passer par le menu des propriétés des 
formes, la boîte de dialogue Shape Filling et l’outil de remplissage de forme à 
gauche de la palette d’outils. 

Remplir une forme avec une couleur unie 
Sélectionnez Solid Color [couleur 
unie] dans la boîte de dialogue. 
Vous pouvez : (1) saisir la 
composante rouge, verte ou bleu 
(gamme de valeurs de 0 à 255) et 
une valeur de transparence 
(gamme de valeurs de 0 à 100), 
(2) choisir avec votre souris dans 
roue de couleur (partiellement 
montrée), (3) utiliser les curseurs 
rouge, vert, bleu, intensité, 
luminance, saturation et 
transparence (cliquez le bouton de 
gauche sous la valeur de 
transparence) ; enfin (4) utiliser un 
compte-gouttes (cliquez le bouton 
de droite sous la valeur de 
transparence) et sélectionner une 
couleur en plaçant le compte-goutte sur une couleur d’une autre forme dans la 
fenêtre d’édition. Pour voir le résultat cochez Preview. En cliquant sur OK, le 
remplissage est appliqué à toutes les formes sélectionnées. 

 

Créer un dégradé de couleur 
Sélectionnez Color Gradient en 
haut de la fenêtre de dialogue. Un 
remplissage en dégradé est 
constitué de huit valeurs de couleur 
au plus. La couleur liée à 
l'indicateur sélectionné est affichée 
sous la barre de définition du 
dégradé. La couleur de l'indicateur 
sélectionné (c'est l'indicateur de 
couleur qui est enfoncé) peut être 
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changée par (1) les valeurs rouges, vertes et bleues (gamme de valeurs de 0 à 255) 
et une valeur de transparence (gamme de 0% à 100%), (2) en choisissant avec la 
souris dans la roue de couleurs (partiellement montrée), (3) en ajustant le rouge, le 
vert, le bleu, la tonalité, la saturation et la transparence, et enfin avec un compte-
gouttes. 
 

 
 
 
 
 
 
 
 
 
 
 

 
Le dégradé de couleurs peut être linéaire ou radial. Les curseurs de couleur peuvent 
être glissés vers le gauche ou la droite le long de la barre de définition du dégradé 

pour en changer l'effet. Pour ajouter une nouvelle 
valeur de couleur cliquez sur le petit bouton avec 
le plus (+). Le curseur de la souris se transforme 
en indicateur de couleur avec le + au milieu. 
Cliquez à une position sur la barre de définition de 
gradient. Changez alors la couleur de cet 
indicateur. Un indicateur peut être supprimé en 
appuyant sur le petit bouton avec le signe moins 
(-) ; l'indicateur sélectionné est supprimé. 
 
 
 
 
 
 

 
 
 

Voici un exemple de sélection 
d’une forme rectangulaire remplie avec un dégradé 
linéaire.  
 
Seules les formes décrites par des points de contrôle 
peuvent être remplies de couleur en dégradé. Pour 
remplir un texte avec une couleur en dégradé 

décomposez sa forme en éléments (Text > onglet Transforms / Break Apart 
Text). 
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L'orientation et l’inclinaison des hachures de 
remplissage du dégradé peuvent être 
ajustées avec les outils Rotate/Shift 
Gradient Fill sous l’onglet Transforms. 
 
 
 
 
 

Déplacer le centre du dégradé vers la droite décale celui-ci à 
droite.  
 

Déplacer le curseur autour du centre du dégradé fait 
tourner celui-ci. 
 
 
 
 
 

Remplir avec une image 

 
Choisissez Image (haut de la zone de dialogue). Utilisez le bouton de navigation 
« … » pour sélectionnez l’image à charger. Les formats bmp, jpeg, tiff, pcx et png 
peuvent être importés. La transparence dans des fichiers png est pour le moment 
ignorée. Si vous employez plusieurs fois le même fichier image pour une animation, 
KoolMoves ne stockera qu’une seule version de celui-ci dans le fichier Flash ™ 
exporté. Si la photo est plus grande que la forme à remplir, seule la partie 
supérieure gauche de la photo sera affichée (mais vous pourrez la recentrer). Si la 
photo est plus petite que la forme dans une dimension au moins, un pavage de 
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photos recouvrira celle-ci. Seules les formes composées de points peut être remplie 
avec une image. La transparence de l’image peut être ajustée avec un curseur. 
 
Vous pouvez pré-visualiser le remplissage en cliquant sur Preview. En cliquant OK 
le motif de remplissage, la couleur, le dégradé, ou la photographie, seront appliqués 
à toutes les formes sélectionnées. Et si le remplissage est une couleur, à tous les 
textes sélectionnés. 
.
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Historique 
Dans le menu Edit l’item Undo history affiche un historique des éditions effectuées 
dans l’image clé courante. Vous pouvez revenir en amont à n’importe lequel des 
états antérieurs en sélectionnant dans cette liste. Redo history fonctionne en aval 
de la même façon. 
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Vitesse de défilement de l’animation 
La vitesse de défilement de l’animation est positionnée dans la barre de menu 
Movie. La vitesse réelle peut cependant être inférieure à la vitesse désirée en 
fonction des performances de la machine. Par exemple les animations avec 
beaucoup d’effets de transparence seront en général ralenties. Une valeur 
raisonnable sera entre 12 et 24 images par seconde [FPS : frames per second]. La 
vitesse effective dépendra de la puissance de l’ordinateur jouant l’animation. Par 
exemple pour une valeur de 18-24 images par seconde sur une machine ancienne 
celle-ci peut monter à 24-30 FPS sur une machine récente et 40-50 sur une 
machine très récente. La visionneuse Flash ™ peut devenir instable aux alentours 
de 35 FPS.
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Coller des formes 
Il y a trois types de copier/coller – vers l’image clé courante de l’animation, depuis 
l’image courante vers la première image clé, vers la dernière image clé. 
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Sélectionner les formes de la même couleur [Select Same Color] 
Vous pouvez sélectionner toutes les formes ayant la même couleur que la forme 
couranteen utilisant cette focntion. 
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Sélectionner / Déplacer [Select / Move] 
Select / Move s’applique aux formes et individuellement aux points des formes. Il 
y a quatre types de sélections :  
L’image clé courante (la plus commune). 
L’animation toute entière 
Toutes les images clé depuis l’image courante jusqu’à la première image de 
l’animation. 
Toutes les images depuis l’image courante jusqu’à la dernière image de l’animation. 
La possibilité de sélectionner des intervalles d’images est très puissante. Par 
exemple si vous changez la couleur d’une forme dans l’image courante et que cette 
forme est sélectionnée dans plusieurs images, la modification de couleur sera 
appliquée à chacune des formes sélectionnées. Pour prévenir les modifications 
intempestives vous devez confirmer l’application de la modification aux autres 
formes. Cette possibilité de modifier des formes et des points sélectionnés sur 
plusieurs images en se basant sur ce que vous êtes en train de modifier dans 
l’image courante s’applique à la plupart des fonctions de KoolMoves – 
transformations, couleurs, translations, etc. 
 
Points et formes sélectionnés peuvent être déplacés avec les flèches curseur. 
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Insertion d’un copie d’image clé 
Insérer une copie de l’image clé courante à la fin de l’animation ou juste après 
l’image courante est le principal moyen de faire progresser l’animation. La copie 
fournit le point de départ des modifications de l’étape suivante de l’animation, qui 
peut impliquer des modifications de position de certains points, de formes et de 
couleurs. Quand une copie d’image clé est faite les formes de la nouvelle image 
conservent un lien avec celles de l’image oiginale, ce qui permet ensuite d’appliquer 
une anamorphose. 
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Conversion d’un texte en forme 
Cette fonction convertit une chaîne de caractères (un objet texte) en une forme 
composée de points (des sommets de segments). Vous ne l’utiliserez que pour 
pouvoir appliquer des transformations au texte de type incliner [slant] ou 
perspective, ou pour manipuler individuellement des points cotrôlant les caractères 
du texte. Ou pour utiliser une image mosaïque ou un remplissage en dégradé. Les 
objets de type Texte ont une représentation très efficace car leurs caractères 
peuvent être partagés par d’autres chaînes de caractères de même police.
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Visionneuse autonome  
KoolMoves vous permer de visionner votre animation avec une visionneuse interne 
et avec une visionneuse Flash ™ autonome si vous avez une d'installée. Si vous 
avez acquis le programme Flash de Macromedia, votre visonneuse apparaît 
assurément dans le dossier Macromedia du programme.  
Il se nomme SAFlashPlayer.exe.
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Visionner dans un navigateur Web 
KoolMoves vous permet de visionner votre animation dans votre navigateur par 
défaut. Sélectionnez simplement « Play in Web browser » dans le menu Play. 
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Affichage pas à pas 
Le mode pas à pas [Single step] permet de visionner les transformations 
d’anamorphose entre chaque trame. Cela vous aide à décider s’il convinet 
d’augmenter ou de réduire le nombre d’images jumelles [tweens]. Pour sortir du 
mode pas à pas appuyez sur ESC ou sur le bouton Stop.
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Polices de caractères 
[Text Fonts] Seules les police de caractère TrueFont qui ne sont pas transformées 
en symbole peuvent être sélectionnées comme objet texte.
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Texte vers caractères 
La fonction Text to Characters décompose une chaîne texte en autant de chaînes 
qu’il y a de caractères la composant. 
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Espacement des caractères 
Letter spacing est un fonction qui permet de rendre un texte plus élégant en 
espaçant les caractères. Malheureusement le texte affiché dans la boîte de dialogue 
est restitué pour le moment comme si l’espacement des lettres était nul.
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Restitution de haute qualité 
High quality rendering signifie anti-crénelage [antialiasing]. C’est une technique 
de filtrage d’imagee qui lisse les bordures d’un élément graphique pour éliminer les 
irrégularités dues à l’affichage mosaïque. 
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Qualité des fichiers JPEG 
A nombre de 0 à 100 peut être choisi. Une valeur faible produit une image de faible 
qualité mais de taille relativement faible. Cette valeur est attribuée dans File > 
Export Settings et dans Movie > Background Image.
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Poids de l’animation 
Le poids du fichier SWF de l’animation et attribué dans la barre de menu Movie. 
Cette valeur doit être indiquée dans le fichier html en même temps que le nom du 
fichier .swf dans les paramètres d’appel.
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Performances 
Les performances de la visionneuse Flash™ sont influencées par de nombreux 
facteurs – le nombre de formes et de points dans chaque image, le degré de 
transparence utilisé, etc. Les performances de la visionneuse interne de KoolMoves 
sont influencées par les mêmes facteurs. En général, la visionneuse KoolMoves n’est 
pas aussi efficiente que celle de Flash™, en particulier au regard de la restitution 
des formes contenant des transparences et des images mosaïques en remplissage. 
La performance sur un site web est un problème différent surtout dû aux limitations 
propres à l’Internet comme la vitesse de transfert des fichiers, la vitesse des 
modem et autres goulots d’étranglement chez le fournisseur d’accès Internet, etc.
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Trames intermédiaires 
Vous pouvez indiquer dans la barre de menu Frames le nombre de trames 
intermédiaires entre deux images clé qui deviendra la valeur par défaut sauf pour 
les images clé qui ont reçu une valeur spécifique. Modifier cette valeur modifie le 
nombre d’images intermédiaires pour toute l’animation.
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Remplissage 
Indique si l’intérieur d’une forme est rempli ou transparent. Une forme peut être 
remplie avec une couleur unie ou une image mosaïque.
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Forme source d’anamorphose 
La fonction Morph Source  vous permet d’interpoler entre deux formes qui ne sont 
pas actuellement interpolées . c’est particulièrement pratique si vous insérez une 
animation dans l’animation courante et que vous voulez que les formes de 
l’animation courante s’interpolent avec celles de l’animation insérée. Chaque forme 
ne peut avoir qu’une seule source d’anamorphose (interpolation). La boîte de 
dialogue Morph Source demande de désigner pour chaque forme sélectionnée de 
l’image clé courante une forme source d’anamorphose dans l’image clé précédante.
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Dérouler les trames [Pan Tweens] 
Pour économiser de l’espace d’affichage l’interface KoolMoves n’utilise pas 
d’ascenseurs. Pour naviguer dans l’espace de dessin, et en particulier avec le loupe, 
utilisez la fonction Pan. Cliquez le bouton gauche de la souris et glissez le pointeur 
souris pour translater la fenêtre d’affichage.
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Sans bordure 
[No Border] L’épaisseur des bordure d’une forme est un nombre entier de pixels. 
Une forme avec une bordure de valeur 0 est restituée sans bordure.
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Bord refermé 
Closed border signifie que la bordure est refermée [closed] et la forme remplie 
[filled]. Cette propriété est positionnée dans le meunu pop-up Properties de la 
forme concernée. Une ligne est une forme dont la bordure n’est ni refermée ni 
remplie (i.e. les propriétés Closed et Filled sont à off). Ces états Closed et Filled 
peuvent être basculés par sélection. 
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Bordures avec des transparences 
Les bordures qui ont un certain degré de transparence ne sont pas restitués 
correctement dans la visionneuse interne de KoolMovesmais sont exportés 
correctement vers une animation Shockwave Flash™. 
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Flash 
Flash™ a été développé par Macromedia pour la création de sites web avec un 
graphisme percutant, des animations vivantes, des sons, une interface interactive. 
Flash utilise un format d’images vectorisées très compact pour un chargement 
rapide des pages web contenant des animations Flash. Flash a une grande diffusion, 
ce qui en fait un choix idéal pour créer des sites web à fort contenu graphique. La 
plupart des navigateurs disposent d’une visionneuse Flash qui restitue les 
animations Flash encapsulées dans une page HTML. De nombreus sites web de 
grande qualité utilisent des animations Flash. Pour plus d’information concernant 
Flash, visitez http://www.Macromedia.com ou http://www.FlashKit.com . 
 
 

http://www.Macromedia.com
http://www.FlashKit.com
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Grille 
Pour une assistance à l’alignment, positionnez une grille et choisissez sa maille avec 
le menu View/Grid. Affichez la grille “par dessus la fenêtre d’animation [on top of 
the animation]” ou « sous l’animation [under the animation] dans le menu 
File/Preferences. 
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Pelures d’oignon [Onion Skinning] 
Cette option [Onion skinning] vous permet de visionner, en plus de l’image clé 
courante, les images d’avant et d’après. Plus les images clé sont éloignées de 
l’image courante plus elles sont atténuées. On peut aussi utiliser cette option pour 
observer le mouvement ou les changements dans l’animation et s’assurer de sa 
fluidité. Pour activer cette option [onion skinning], sélectionnez View/Onion 
Skinning et cochez-la. 
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Movie Looping 
Pour activer la réptition en boucle [Movie Looping] de l’animation Flash dans le 
fichier HTML, modifiez la propriété File > Export Settings > HTML Settings. 
Cliquez sur l’item du menu pour basculer sa valeur. Ce paramètre posititionne le 
paramètre de boucle dans code javascript en deux endroits du fichier HTML. 
Alternativement, vous pouvez placer une commande stop [Stop Action] à la fin de 
l’image clé avec Views > Actions and Sounds. 



Edition d’images clé [Frame Editing] 
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Editer les images clé 
Voir Editer et visionner des images [Editing and Playing Frames].



Transparence 
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Transparence 
Les couleurs unies et les dégradés peuvent être semi-transparents. Dans la boîte de 
dialogue de remplissage de formes il y a une zone de saisie pour la valeur de 
transparence sous la zone destinée à saisir la composante bleue de la coleur. 
L’intervalle de transparence est de 0 (opaque) à 255 (totallement transparent). 
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Compression du son 
Le format de fichier Flash propose différents niveaux de compression audio pour les 
fichiers WAV sous forme de nombre de bits (2 - 5) à utiliser pour représenter le son 
acquis en format 16 bits. 2 bits est la moins bonne qualité et 5 la meilleure. Cette 
valeur est à placer dans File > Export Settings. 
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Importer des images [Import Bitmap] 
Cette fonction, accessible par File > Import Image, rempli un rectangle avec le 
contenu du fichier image sélectionné. Les quatre sommets du rectangle peuvent 
être individuellement déplacés ou des sommets supplémentaires ajoutés. Vous 
pouvez aussi créer une forme et la remplir avec l’outil de remplissage de forme (lire 
le chapitre Colorer). 
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Importer des fichiers de dessin vectorisé WMF, EMF 
Lire Importer des Clipart 
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Importer des fichiers AutoCad ™ DXF 
Lire Importer des Clipart. L’information de remplissage couleur peut n’être pas 
récupérée 
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Importer des fichers Postcript encapsulé (EPS) 
EPS est un format difficile à importer dans KoolMoves. Cee doit être de l’EPS 3.0 ne 
contenant des formes vectorisées et pas seulement des bitmap (images mosaïques)  
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Intégrer des fichiers audio 
Voir Sonoriser des Images et Sonoriser des Boutons. 
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Sonoriser des Images 
Les sons (MP3 et .wav au format PCM) peuvent être ajoutés aux animations 
KoolMoves. Sélectionner Views > Sounds and Action pour invoquer une boîte de 
dialogue qui vous permettra d’ajouters et de supprimer des sons dans les images 
clé. Il y a environ 68 formats Wav différents ; pour le moment KoolMoves ne 
supporte que le type PCM. 
 
Si vous utilisez le même fichier audio plusieurs fois dans la même animation, il sera 
référencé autant de fois dans le fichier Flash ™ mais défini (stocké) une seule fois. 
Les fichiers audio tendent à prendre beaucoup de place et à grossir 
considérablement le ficher SWF exporté. Pour réduire la taille des objets sonores, 
procédez ainsi : convertissez les sons stéréo en mono avec un éditeur de fichiers 
audio ; échantillonnez avec la qualité minimale en fonction des besoins. Raccourcir 
la piste audio peut aussi servir. 
 
Des sons peuvent aussi ête attachés à des états de boutons (par exemple déplacer 
la souris par dessus un bouton ou presser celui-ci). Voir Sonoriser des Boutons pour 
plus d’information. 
 
Les sons ne s’exécutent pas dans la visionneuse interne de KoolMoves. 
 
Si la durée d’une séquence sonore est plus grande que l’animation qui la contient et 
que celle-ci est jouée en boucle, la séquence sonore de la première boucle se 
poursuit dans la suivante jusqu’à sa fin. L’effet sonore se dégrade au fur et à 
mesure que l’animation tourne en boucle. Pour résoudre ce problème introduire une 
commande Stop Sound à la dernière image clé de l’animation. 
 
Si le fichier audio est échantilloné à des valeurs différentes de 5500 ; 11025, 22050 
ou 44100, la séquence sonore sera exécutée dans Flash au taux le plus proche de 
ceux listés ci-dessus.
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Fichiers audio MP3 
Voir Sonoriser des Images et Sonoriser un bouton 
.
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Réactivité d’un bouton 
La zone de réactivité d’un bouton à l’action de la souris est positionnée dans la boîte 
de dialogue des propriétés d’une forme. Cette zone est exprimée en pourcentage de 
la taille du bouton en état levé [Up state]. En d’autres mots une zone de 200% est 
deux fois plus large et deux fois plus haute que le contour du bouton quand la souris 
ne le survole pas. 
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Sauvegarde 
Quand vous enregistrez votre animation un fichier de secours est créé sous le nom 
~backup.fun.
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Taux de rafraîchissement des images 
La vidéo et la télévision ont des vitesses de rafraîchissement de 30 images par 
seconde [30 fps] et le cinéma de 24 images par seconde. La plupart des dessins 
animés sont réalisés à 12 ou 15 images par seconde pour des motifs économiques 
alors que les animations de très haute qualité comme celles de Disney utilisent une 
rafraîchissement de 24 ou 30 fps. Des taux supérieurs produisent des animations 
plus fluides mais nécessitent plus de trames intermédiaires entre deux images clé 
pour la même durée de film. 
 
La visionneuse Flash 4 ne peut dépasser 18 images par seconde. La visionneuse 
Flash 5 essayera de jouer au taux maximal au dépend de la consommation des 
ressources système. Les animations avec un taux de rafraîchissement supérieur ou 
égal à 30 fps jouées sur une visionneuse Flash 5 mais testées sur une visionneuse 
Flash 4 sembleront considérablement accélérées (Voir la note technique : 
http://www.macromedia.com/support/flash/ts/documents/player5_issues.htm) et 
pourront causer des crashes machine ou des blocages. Comme il est recommandé 
dans les notes techniques, les utilisateurs ne doivent jamais utiliser un taux de 
rafraîchissement de 30 fps ou plus sans de très bonnes raisons. 
 
Le taux de rafraîchissement est sélectionné dans Movie / Speed. 
 

http://www.macromedia.com/support/flash/ts/documents/player5_issues.htm
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Editeurs audio 
La liste des éditeurs audio gratuits [graticiels : freeware] ou partagés [shareware] 
est limitée : 
 
DigiDesign, un éditeur gratuit très puissant , 
http://www.digidesign.com/flashnav/index.html 
 
ALF, un encodeur WAV vers MP3, http://philnet.u-net.com 
 
Des convertisseurs de fichier audio : http://www.dbpoweramp.com 
 
ASIA, un éditeur d’onde gratuit, 
http://www.geocities.com/SiliconValley/platform/9182/ 
 
Windows Media Player et Windows Sound Recorder peuvent être utilisés pour créer 
des fichier Wav et pour convertir quantité de formats audio en fichier WAV. 
 
GoldWave, un shrareware à 40 $, http://www.goldwave.com 
 
Audio Mulch, shareware à 50 $, http://www.audiomulch.com/index.htm 
 
Audacity, un éditeur audio multi plateforme gratuit en OpenSource, 
http://.audacity.sourceforge.net/ 

http://www.digidesign.com/flashnav/index.html
http://philnet.u-net.com
http://www.dbpoweramp.com
http://www.geocities.com/SiliconValley/platform/9182/
http://www.goldwave.com
http://www.audiomulch.com/index.htm
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Préférences 

Préférences d’affichage : 
Style d’interface utilisateur [User interface style]. Permet à l’utilisateur de 
sélectionner une interface adaptée à son niveau de compétence. L’utilisation 
avancée comprend le masquage, la manipulation des points d’une forme, les scripts 
d’action. L’interface pour la création de Dessins animés [Cartooning] comprend les 
squelettes de formes et l’interpolation non linéaire. 
 
Grille d’alignement [Draw alignment grid on top]. Si cette option est sélectinnée, 
une grille est disposée par dessus tous les objets de la fenêtre d’animation. Sinon la 
grille est affichée en dessous des formes mais par dessus l’arrière plan. 
 
Couleur de la fenêtre [Canvas Color]. C’est la couleur d’affichage de le fenêtre de 
l’application en dehors de la zone d’animation. 
 
Taille des caractères [Font size]. Ce paramètre affecte l’affichage des fenêtres de 
Propriétés et de listes de formes et d’images clé ainsi que le texte de certaines 
barres d’outils. 
 

Préférences pour le Tracé et la Sélection : 
Tracer les formes comme symboles [Draw shapes as symbols]. Avec cette option 
cochée, les formes sont tracées comme des symboles. Cela réduit considérablement 
le poids du fichier SWF final. L’inconvénient c’est que les points décrivant la forme 
ne peuvent pas être déplacés individuellement sans affecter la même forme de 
toutes les autres images clé... Si vous faites une animation de personnages 
[cartooning] invalidez cette option [turn off]. 
 
Rester en mode de tracé [Remain in drawing mode] après avoir tracé une forme. Si 
cette option est sélectionnée, vous pouvez redessiner une formes sans avoir à 
resélectionner l’outil dessin. Sinon l’outil de sélection / déplacement devient l’outil 
courant après le dessin d’une forme. 
 
Conserver la sélection de points et de formes [Retain shape/point selection] en 
changeant d’image clé. Si cette option est sélectionnée la forme ou le point courant 
reste sélectionné quand vous passez à une autre image clé. Sinon elle (il) n’est plus 
sélectionné(e). 

Préférences pour l’éditeur audio 
Vous pouvez assigner jusqu'à 6 éditeurs 
audio pour vous aider à créer des bruitages 
et des sonorisations d’images et de 
boutons. Cliquez sur le bouton Add. Un 
popup est affiché. Cliquez sur le bouton de 
lecture rapide (3 points « … ») et 
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sélectionnez l'exécutable correspondant à un clip audio. Pendant l’ajout de bruitage 
aux images et aux boutons, vous pouvez cliquer sur le bouton d’édition des sons et 
un menu affichera les postes sonsores que vous avez assignées. La sélection d’une 
poiste sonore appellera l’éditeur correspondant.  

Préférences pour l’éditeur d’images  
Vous pouvez assigner jusqu'à 6 éditeurs d’images. Cliquez sur le bouton Add. Un 
popup est affiché. Cliquez sur le bouton de lecture rapide (3 points « … ») et 
sélectionnez l'exécutable correspondant à un éditeur d’images. Les éditeurs sont 
accessibles par l'icône de pinceau à l’onglet Filling du popup pour le remplissage de 
couleurs.  

Préférences pour la visionneuse  
Vous pouvez assigner un dossier pour les animations à visionner. Chaque fois que 
vous ouvrez un fichier KoolMoves .fun, le dossier d’animation est réaffecté à ce 
dossier. 
 
Préférences Stabilité interne maximum. Par défaut à On. Ralentira légèrement la 
visionneuse interne. Si vous ne constatez pas d’à coup ou des problèmes de rupture 
de flux lors de l’affichage de textes invalidez cette option.  
 

Préférences pour les bibliothèques de formes 
Vous pouvez assigner des dossiers par défaut pour chacune des bibliothèques.  
 

Préférences pour les squelettes 
Couleur des squelettes. 
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Justification des textes  
Les textes sur plusieurs lignes peuvent être alignés à gauche, à droite, centrés ou 
justifiés. Et dans ce sdernier cas laa dernière ligne de texte est alignée à gauche. 
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Verrouillage de formes 
Pour verrouiller des formes sélectionnées (empêcher un déplacement de sommet de 
la forme ou tout autre modification intempestive, cliquez le bouton Lock dans le 
popup de la liste des formes. Pour déverrouiller, re-cliquez. Pour verrouiller ou 
déverrouiller toutes les formes cliquez sur Lock All Button. 
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Création d’économiseurs d’écran 
Les navigateur SWF de http://www.swifftools.com/stools/ permettent de parcourir 
les fichiers .swf, créer des économiseurs d’écran et des diaporamas (fichiers .exe à 
partir de fichiers.swf). 
 
Bien que ce produit soit gratuit, quelques fonctions comme la sonorisation l’export 
swf et l’extraction d’image sont verrouillées tant que vous n’avez pas acheté le 
produit. 
 
SWF Studio, http://www.northcode.com, est un autre produit très pratique. 

http://www.swifftools.com/stools/
http://www.northcode.com
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Génération de fichiers EXEcutables 
Les navigateur SWF de http://www.swifftools.com/stools/ permettent de parcourir 
les fichiers .swf, créer des économiseurs d’écran et des diaporamas (fichiers .exe à 
partir de fichiers.swf). 
 
Bien que ce produit soit gratuit, quelques fonctions comme la sonorisation l’export 
swf et l’extraction d’image sont verrouillées tant que vous n’avez pas acheté le 
produit. 
 
SWF Studio, http://www.northcode.com, est un autre produit très pratique. 

http://www.swifftools.com/stools/
http://www.northcode.com
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Conversion AVI  
Il y a deux méthodes.  
 
Méthode 1 : Exportation comme une séquence d’images et création du fichier AVI 
avec votre logiciel d’édition AVI préféré (il y en a des tas de gratuits) ou conversion 
en AVI avec MS Movie Maker qui est fourni avec Windows XP. 
 
Méthode 2 : Employer SWF2Video ($19.00),  http://www.flashants.com/ ou 
SWF2AVI ($79), http://www.pizzinini.net/swfavi/ 
 
SWF2AVI convertit n'importe quel SWF en fichier AVI. L'AVI peut alors être exporté 
comme Séquence d’images [Image Sequence] avec de nombreux d’outils d’édition 
tels que QuickTime. QuickTime peut aussi convertir les fichiers SWF directement en 
séquences d’images. Pour convertir un AVI en SWF, employez CamStudio 
http://www.rendersoftware.com/products/camstudio/  

http://www.flashants.com/
http://www.pizzinini.net/swfavi/
http://www.rendersoftware.com/products/camstudio/
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Ombre portée 
Dans la boîte de dialogue des propriétés vous pouvez ajouter une ombre portée  
[Drop shadows] à n’importe quelle forme. Cette propriété est dans la section des 
Effects. L’ombre portée ne fonctionne pas bien avec les transitions par atténuation 
[fade in ou fade out]. 
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Dépendances 
Movie > Dependencies affiche une liste de tous les fichiers utilsés ou référencés 
par l’animation -- images, sons, fihcier SWF importés, et lines Internet. C’est utile 
pour la vérification  des noms de fichiers et pour avoir une vue d’ensemble des 
dépendances de fichier. 
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Traitement des formulaires 
Consultez ces sites web pour obtenir des informations sur les scripts de traitement 
des données saisies avec des formulaires HTML. 
http://www.bignosebird.com/lscgi.shtml 
http://worldwidemart.com/scripts/ 
http://www.cgi-resources.com/ 
http://cgi.resourceindex.com/Programs_and_Scripts/ 
 
L’interface de saisie est facile à réaliser. Tout ce qu’il y a à faire c’est soit de créer 
une interface entre deux balises <form> </form> (méthode Get ou Post), soit de 
transmettre le contenu des variables directement dans l’URL pointant vers un script 
CGI (ou autre exécutable) côté serveur (méthode Get). Le protocole HTTP adresse 
au serveur toutes les variables initialisées dans le client pour un traitement par un 
exécutable... 
 
Voici quelques exemples de code  
 

Code ASP pour charger des variables 
 
code: 
--------------------------------------------------- 
<% 
' initial setup (recommended) 
Option Explicit ' Forces declaration of variables 
Response.Buffer = true ' Don't output page until script finished 
Response.Expires = -1441 ' Attempt to overcoming browser cache probs 
' declare some variables 
dim strFirstName, strLastName 
' get the info 
strFirstName = "" & request.form("firstname") 
strLastName = "" & request.form("lastname") 
' process as desired 
%>  
------------------------------------------ 
 
Dans ce code ASP "firstname" et "lastname" sont les noms des champs texte de 
saisie du formulaire dans KoolMoves. 
Les trois premières lignes ne sont pas indispensables mais peuvent aider. Il n’est 
pas nécessaire de donner des dimensionner les  variables (mot réservé DIM) si 
l’option Option Explicit n’est pas utilisée. 
Comportement standart :  KoolMoves crée u fichier .swf qui adresse les données 
saisies correctement à un  script ASP côté serveur. 
 
Cette information peut alors être utilisée dans une page HTML  comme ceci : 
code: 
------------------------- 

http://www.bignosebird.com/lscgi.shtml
http://worldwidemart.com/scripts/
http://www.cgi-resources.com/
http://cgi.resourceindex.com/Programs_and_Scripts/
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Hello <%=strFirstName%> 
etc  
 
-------------- 
 

Code en VB Script 
 
code: 
-------------- 
<%@ LANGUAGE="VBSCRIPT" %> 
<% response.expires = 0 %> 
<% 
sMail = sMail & "You Can Put Anything You want here- It is attached to the Body" & 
vbcrlf & vbcrlf 
sMail = sMail & vbtab & "AnyQuestion you want answered - " & request("Any 
Variable you want") & 
vbcrlf 
Set Mailer = Server.CreateObject("SMTPsvg.Mailer") 
Mailer.RemoteHost = "your mail server" 
Mailer.Subject = "anything you want " 
Submitter = request("Var you set for the senders name") 
Mailer.FromName = "any name you want" 
Mailer.FromAddress = "any adress you want" 
Mailer.BodyText = sMail 
Mailer.AddRecipient "name of who you want to send to", "E-Mail of person you want 
to send to" 
%> 
 

Code en Perl 
code: 
---------------------------------------------------  
#!/usr/bin/perl 
require "subparseform.lib"; 
&Parse_Form; 
$Title = $formdata{'Title'}; 
$Contact = $formdata{'Contact'}; 
$About = $formdata{'About'}; 
$News = $formdata{'News'}; 
$Products = $formdata{'Products'}; 
$Link = $formdata{'Link'}; 
@New = 
("Title=$Title&Contact=$Contact&About=$About&Products=$Products&News=$New
s&Link=$Link"); 
open (LOG, ">/home/formexample/TextFile.txt") || &ErrorMessage; 
print LOG "@New";  
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close (LOG); 
print "Content-type: text/html\n\n";  
print "Status=Success - Your Comments have beed updated. Please return to the 
main area to see the results"; 
sub ErrorMessage {  
print "Content-type: text/html\n\n";  
print "Status=Connection Failed Please check the path to the text File";  
exit;  
} 
 
-------------------------------------------------- 
 
Ce script recherche les variables Title, Contact, About, News, Products, et Links et 
les écrit dans un fichier texte nommé TextFile et génère une page HTML qui affiche 
les valeurs soumises. Le script est adaptable en modifiant le nom des variables dans 
la première partie du script pour qu’ils correspondent aux noms donnés dans le 
fichier SWF que vous avez créé. N’oubliez pas de les renommer dans la ligne @New 
=("… 
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Tracer des lignes d’épaisseur variable 
Il y a deux façons de d’obtenir une ligne d’épaisseur variable : 
 
1. Dessiner deux formes de lignes, l’une sur l’autre. Chacune reçoit une bordure 
d’épaisseur nulle. La forme en arrière plan est alors affectée d’une bordure de la 
couleur voulue et vous en ajustez localement la position en la faisant légèrement 
plus grande que la forme du dessus ; vous obtenez ainsi l’effet désiré... 
 
2. Pour réaliser une ligne qui ait l’air d’avoir été tracée à la main (avec de petits 
tremblements) tracez une seule forme avec une ligne d’épaisseur 1. Puis parcourez 
la ligne et placez quelques sommets additionnels et quelques portions de courbes au 
hasard. Déplacez ensuite légèrement ces points et lignes courbes comme pour un 
tracé au crayon, jusqu’à ce que la ligne semble tracée à la main. Elle reste à peu 
près droite sur toute sa longeur avec de petites variations d’épaisseur qui la rend 
plus naturelle. 
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Création de diaporama 
Voir Création d’un exécutable. 
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Message d’erreur “Exceeded SWF Buffer Size” 
La plupart du temps ce message d’erreur vient de l’utilisation d’un fichier audio WAV 
qui fait plus de 1/2 MB. Le mieux est soit de convertir de fichier en fichier MP3 qui 
n’a pas de limitation de taille ou d’ajuster le taux de compression du fichier WAV 
dans Movie > Advanced. 
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Liens Internet 
Pour ajouter une lien vers une page web dans une animation, transformez en 
bouton le texte ou la forme référençant ce lien dans les Propriétés (cliquez ‘yes’ 
pour Is a Button). Dans l’onglet Actions du même menu, ajoutez une commande 
d’action GetUrl ver la page Web à charger. Ouvrez 
Examples\Actions\mouseevents.fun pour un exemple de differents types de liens. 
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Arrière plan transparent 
Il y a une façon de rendre transparent l’arrière plan d’une animation en utilisant le 
paramètre WMODE dans le code javascript du fichier html appelant l’animation mais 
cela a des inconvéninets importants. Netscape sur toutes les plateformes et IE sur 
MAC ou Unix d’aucune version n’utilise WMode. Le seule navigateur qui l’interprète 
est MSIE 4.0 ou plus sous Windows. 
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SWF trop gros 
La visionneuse Flash n’est pas conçue pour jouer de très grosses animations. 
Exécuter une gros fichier swf peut facilement bloquer une ordinateur. Macromedia 
recommende que les fichiers swf ne dépassent pas 2.5 - 3 MB (La mémoire allouée 
par le Mac par défaut est d’environ 2.5 MB). C’est documenté dans 
www.macromedia.com/support/flash/ts/documents/bigflash.htm 
 
Les meilleures options sont soit de réduire la taille de l’animation (en particulier, 
convertir les sons en fichiers MP3 avec des produits comme GoldWave) soit de 
chaîner plusieurs petites animations swf avec la commande d’action Load Movie. 
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Importer des vidéos 
Vous pouvez décomposer le fichier vidéo en séquences d’images et en fichier son 
avec un programme comme QuickTime Pro. Alternativement, vous pouvez employer 
un programme comme MotionSWF, http://ra.sakura.ne.jp/~taos/moswf/ , Wildform 
Flix, SWF Convert, Vid2Flash, Vid2SWF, ou Swideo pour convertir le fichier vidéo en 
fichier SWF. Utilisez alors dans KoolMoves la fonction Import as SWF Object pour 
importer ce fichier dans votre animation KoolMoves.  
 
Si vous la décomposez vous devrez importer la séquence dans KoolMoves à la main 
et ajouter la piste son ensuite.  
 
Si vous employez MotionSWF placez la vidéo dans un dossier et glissez-la dans 
MotionSWF.  
 
Et pour terminer, si vous avez QuickTime 6 Pro (ou même 5 Pro) créez deux pistes 
(une pour l’animation Flash et une pour le son MPG), combinez-les et exportez le 
tout comme un fichier MOV (le format de QuickTime Pro). Ceci est recommandé car 
la visionneuse Flash ne peut pas jouer plus de 8 minutes de vraie vidéo alors que 
QuickTime le peut. 

http://ra.sakura.ne.jp/~taos/moswf/
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Bordure noire 
Utilises le code HTML suivant pour ajouter une bordure noire à votre animation : 
<div style="border: 1px solid black;"> 
<!-- movie code here --> 
</div> 
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PowerPoint  
Vous pouvez obtenir un outil gratuit de Microsoft à  
http://ww.globfx.com/products/swfpoint/ qui ajoute une animation Flash à une 
présentation PowerPoint.  
 
Voir également le http://www.itg.uiuc.edu/help/flash_to_ppt/ .  
 
Alternativement, vous pouvez l'ajouter manuellement. La première chose que vous 
devrez faire c’est de lancer PowerPoint et d’ouvrir la pop-up ToolBox. Sélectionnez 
View > Toolbar > Control toolbox.  
 
Ensuite sélectionnez le bouton More Controls (ressemblant à un marteau et à une 
clé) qui affiche une longue liste de commandes de contrôle – il vous faut le contrôle 
Shockwave Flash Object (s’il n'est pas dans la liste c’est que vous devez installer 
Flash OCX à récupérer sur le site Web de Macromedia.)  
 
Dessinez alors l’endroit où votre votre animation apparaîtra dans la présentation 
PowerPoint. Cela ressemblera à une grand carré avec un X dedans jusqu'à ce que 
vous ayez terminé la mise en forme.  
 
Cliquez avec le bouton droit de la souris dans le carré X et changez ses propriétés. 
Double clic sur la propriété Custom pour assigner à la présentation PowerPoint 
l’URL correcte de l’animation (rappelez-vous que les URL peuvent être locales – Je 
suggère que vous créiez un raccourci vers votre SWF et recopiez et collez l’URL 
affichée par l’option propriété de ce raccourci).  
 
Tant que vous n’exécuterez pas la présentation l’animation SWF s’affichera comme 
un carré X. Cela changera dès que vous lancerez la projection des diapositives.  
 
Tout ceci fonctionne à partir de PowerPoint 97, 2000 et au delà. 
 

http://ww.globfx.com/products/swfpoint/
http://www.itg.uiuc.edu/help/flash_to_ppt/
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Epaisseur des lignes et bordures 
Vous pouvez définir l’épaisseur des lignes et des bordures dessinées dans la barre 
d’outils et vous pouvez changer l’épaisseur dans la boîte de dialogue des propriétés. 
Vous verrez qu’il y a des valeurs de 0.25 et 0.5 pixels, qui ne peuvent pas être 
affichées sur un écran mais qui se justifient pour l’impression du fichier SWF. 
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Envoyer par mél 
Consultez ce tutorial : 
http://www.koolmoves.com/johnie/outlook/KoolMovesandOutlook.html 
 
Il y a un produit bon marché appelé Flash Toolset 
http://www.flashtoolset.com/FTS/features.html qui a une application d’envoi de 
courriel intégrée. 

http://www.koolmoves.com/johnie/outlook/KoolMovesandOutlook.html
http://www.flashtoolset.com/FTS/features.html
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Accès à une base de données 
Pour accéder à une BD avec ASP, voir http://www.haneng.com/lessons_21.asp .  
 
Pour le faire avec PHP, voir 
http://www.phpbuilder.com/columns/siddarth20000228.php3 
 et http:// www.databasejournal.com/features/msaccess/article.php/1405201 .  
 
Autre référence : http://www.mysql.com/products/mysql/index.html 
 

http://www.haneng.com/lessons_21.asp
http://www.phpbuilder.com/columns/siddarth20000228.php3
http://www.databasejournal.com/features/msaccess/article.php/1405201
http://www.mysql.com/products/mysql/index.html
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Importer des fichiers TIF, JPEG, PCX 
Voir Importer des images mosaïques. 
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Importer des fichiers PNG 
Voir Importer des images mosaïques. Les fichiers d’images PNG peuvent être 
importés en 24 bits or 8 bits par pixel sans transparence. Le format PNG (libre de 
droits) remplace l’importation de fichiers GIF qui est un format propriétaire. 
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Fichiers son MIDI 
La visionneuse Flash ne manipule pas directement les fichiers audion au format 
MIDI. Vous devez convertir le fichier MIDI en WAV ou MP3 ou le synchroniser en 
employant d'autres méthodes de la visionneuse Flash et des commandes FS.  
 
Il y a plusieurs applications de conversion du format MIDI en freeware, par exemple 
http://www.polyhedric.com/software/mn/. 
 
http://www.tips-tricks.com/sound.asp propose un tutorial sur la façon d’ajouter un 
son MIDI à un fichier HTML.  
 
Voici du code html qui placera un son midi en fond sonore de votre page web: 
<EMBED SRC="hittheroad.mid" AUTOSTART="True" HIDDEN="True" LOOP= 
"True">  
<BGSOUND SRC="hittheroad.mid" LOOP="infinite"> 

http://www.polyhedric.com/software/mn/
http://www.tips-tricks.com/sound.asp


Importer et exporter des fichiers SVG 

Aide KoolMoves – Traduction jean.fruitet@free.fr - 154/171 

Importer et exporter des fichiers SVG 
Le format SVG (Scalable Vector Graphics) est partiellement supporté pour le 
moment. L’implémentation concerne l’import et l’export des contours. 
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Texte Dynamique  
 Un texte dynamique peut être saisi par 
l'utilisateur ou modifié à l’exécution de 
l'animation. C'est le deuxième choix dans le sous-
menu des textes.  
 
Le champ de saisie dynamique 
est créé en cliquant sur un 

coin, en glissant la souris et en la libérant pour définir le coin 
opposé.  
 
 

 
 
 
Il y a un certain nombre de propriétés 
spécifiques pour indiquer l’aspect du texte 
dynamique. Le type propriété positionne la 
police, le style et la taille des caractères et 
le texte initial. Un texte dynamique est 
différent d’un texte statique en ceci que le 
l’information de lettrage n’est pas intégrée 
au fichier swf. Ce qui a pour avantage de 
faire des fichiers swf beaucoup plus légers. 
Le texte est restitué en utilisant la police 
stockée sur l'ordinateur de l'utilisateur, 
sans anticrénelage. Si la police indiquée 
n'est pas disponible, une police par défaut 
est employée. La propriété de couleur 
définit la couleur du texte. La propriété de 
bordure détermine s'il y a une frontière. Si 
une bordure est positionnée, l’arrière plan 
du champ texte est blanc avec une bordure 
noire. Pour avoir une couleur de fond 

différente, vous devrez invalider l’option bordure et placer derrière l'objet 
dynamique texte une forme avec la couleur et la bordure de votre choix. Si l’option 
Read Only est activée, le texte ne peut pas être modifié par l’utilisateur. 
L'alignement détermine le positionnement du texte. Si l’option multiligne est 
activée, le texte peut se dérouler sur plusieurs lignes. Si le retour automatique à la 
ligne est activé [Word Wrap], le texte ira à la ligne quand la première ligne est 
remplie, etc. Si la barre d’ascenceur est activée, un ascenseur vertical est ajouté du 
côté droit du champ texte. 
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Les détails d’aspect de cet ascenseur sont 
décrits dans les propriétés d’ascenseur. La 
première boîte définit les propriétés du 
curseur et la deuxième boîte définit les 
propriétés de la cage d’ascenseur.  
 
Voici un ascenseur avec 
des paramètres 
adaptés aux besoins du 
client. L’option bordure 
du texte a été invalidée 
et les bordures du 
curseur et de la cage 
ont reçu la valeur 2. Un 
champ texte sans bordure est affiché avec 
une frontière atténuée dans 
l'environnement d'édition.  
 
Dans l'environnement d'édition la zone de 
texte est définie par des diagonales qui 
symbolisent une visionneuse Flash. De plus 
aucun texte n'est affiché dans 
l'environnement d'édition.  
 
Le texte peut être changé ou récupéré en 
cours d’exécution de l'animation en 
utilisant les commandes d’action Set 

Dynamic Text, Load Dynamic Text et Send Form Data. Send Form Data exige côté 
serveur un script adressé par la méthode GET ou par PUT… Consulter 
http://www.pppmail.com/flash4cgi.htm à ce propos.  
 
Si vous employez le caractère ‘&’ dans le texte, la visionneuse Flash l'interprètera 
comme le début d’une nouvelle variable ce qui causera une erreur d’exécution. 
Aussi remplacez les ‘&’ par ‘%26’ (correspondance unicode). Pour plus de détails, 
voir le http://www.macromedia.com/support/flash/ts/documents/url_encoding.htm 
.  

.

http://www.pppmail.com/flash4cgi.htm
http://www.macromedia.com/support/flash/ts/documents/url_encoding.htm
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Scripts d’action 
KoolMoves fournit la possibilité d’utiliser les scripts d'action de Flash 6. Une grande 
part des opérateurs et commandes de  Flash 5 et 6 sont supportés actuellement. Le 
point d'interrogation en haut de l'environnement d'édition énumère la liste des 
syntaxes acceptées. Cette fonctionnalité est considérée comme avancée et exige la 
maîtrise des scripts d’action qui peut être obtenue en consultatnt la littérature et 
sites web consacrés à ce sujet.  
 
Certaines syntaxes de Flash 4 ne sont pas supportées. La seule syntaxe valide pour 
désigner la cible des commandes d’action est la syntaxe de point. Par exemple,  
syntaxe_level0:clip et _ level0/clip de Flash 4 devront être représentées par 
_level0.clip.  
 
Il y a un certain nombre d'exemples de scripts d'action dans le dossier d'exemples. 
http://actionscript-toolbox.com, http://www.actionscripts.org/, et 
http://www.macromedia.com/support/flash/action_scripts.html sont de bonnes 
sources d'information. Le Defenitive Guide to ActionScript par Colin Moock est l'un 
des meilleurs livres sur le sujet. Une autre approche est d'apprendre Javascript 
parce que le langage de scripts d'action de Flash est fondamentalement Javascript. 
Voici un bon guide Javascript : 
http://www.oreillynet.com/pub/a/javascript/2001/%2012/07/action.html 
 
Notez que si vous employez des actions gotoAndPlay ou gotoAndStop et si vous 
employez le preloader de KoolMoves, 2 images sont automatiquement ajoutés par 
KoolMoves au début de l’animation.  
 
Notez en outre que dans gotoAndPlay, la première image du film est 1 et non 0. 
C'est une moindre source d'erreur de nommer les images clé et de les désigner par 
ce nom plutôt que par leur numéro dans les commandes d’action d’adressage.  
 
La commande Stop Movie ne devrait pas être placée sur la première image clé. De 
fait la vérification des erreurs devrait empêcher celle-ci. Une commande Stop Movie 
sur la première image est souvent ignorée par la visionneuse Flash. 
 
Dans Flash 6 un texte dynamique dispose à la fois d’un nom d’instance et d’un nom 
de variable dans l’éditeur Flash. Des attributs d'objet comme 'text' et '_x 'sont 
associés au nom d'instance qui dans KoolMoves est le nom de l'objet, par exemple 
« txt1 ». Le nom de variable est employé pour la compatibilité arrière pour des 
instructions d'affectation comme = "bonjour". L'interface de KoolMoves ne supporte 
pas simultanément un nom d’instance et un nom de variable en raison de la 
confusion liée au fait d’avoir deux noms pour fondamentalement le même objet. 
KoolMoves associe automatiquement un nom de variable à tous les objets textes 
dynamiques de Flash 6 en prenant le nom d’instance auquel il ajoute « var ». Par 
exemple si le nom d'un objet texte dynamique texte est « txt1 », lors de l’export 
Flash 6 le nom de variable sera « txt1var » et le nom d’instance « txt1 ». Pour Flash 
4 et 5 l'objet texte dynamique appelé « txt1 » sera exporté sous le nom de variable 
« txt1 ». Ceci semble la façon la plus simple de gérer la situation.  

http://actionscript-toolbox.com
http://www.actionscripts.org/
http://www.macromedia.com/support/flash/action_scripts.html
http://www.oreillynet.com/pub/a/javascript/2001/%2012/07/action.html
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Ces instructions sont valides pour l'exportation vers Flash 6 :  
txt1var = "bonjour" ;  
txt1.text = "bonjour" ;  
txt1._x = 200 ;  
 
Ces instructions sont valides pour l'exportation vers Flash 4 et 5 :  
txt1 = "bonjour" ;  
txt1._x = 200 ; 
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Composants d’interface 
Il y a actuellement au total 7 composants pour gérer les intérction avec l’utilisateur 
dans une animation flash : scroll pane (panneau déroulant), list box (liste), check 
box (case à cocher), push button (bouton poussoir), scroll bar (ascenseur), 
database query object (requête vers une BD) et tooltip (outil). Il y a des exemples 
détaillés et des fichiers lisez-moi dans la section Composant [Components] dans le 
dossier Examples. 
 
Deux images clés sont ajoutées au fichier swf exporté par KoolMoves au début de 
l’animation principale avant tout préchargement pour charger le fichier 
KComponents.swf. KComponents.swf contient tous les composants de création, 
dessin et routines d’interaction. Pour son exécution KComponents.swf doit être 
présent dans le même dossier que le fichier SWF principal de l’animation. A 
l’exportation vers un fichier swf ou lors de la prévisualisation, le fichier 
KComponents.swf est copié dans le dossier de travail si des composants ont été 
ajoutés au moyen de l’interface graphique utilisateur de KoolMoves ou si "include 
interface components" est coché dans Export Settings. Les composants sont 
exportés en Flash 6.  
 
Les composants d’interface peuvent être ajoutés au moyen de la barre d’outils Tools 
ou au moyen de scripts d’action (voir La section Components dans le dossier 
Examples pour des exemples de scripts d’actions).
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Interpolation non linéaire  
L’anamorphose standard nécessite l'interpolation linéaire entre deux images clé 
adjacentes. C'est suffisant pour la plupart des situations mais ne produit pas de 
bons résultats quand il y a un mouvement de rotation. L’interpolation non linéaire, 
qui implique un ajustement cubique entre 4 images clé fournit une meilleure 
représentation du mouvement mais a comme conséquence un alourdissement du 
fichier swf. Si l'option Morphing non linear est sélectionnée et qu’il y a moins de 4 
images clé du déplacement, l’interpolation linéaire normale est automatiquement 
appliquée. L’anamorphose non linéaire n’est disponible que dans le modèle 
d'interface Cartooning.
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Score View 

 
Une vue très pratique de l’animation est obtenue dans la fenêtre Score. Quand vous 
appuyez sur le bouton score la fenêtre Score flotte dans l’espace de travail et peut 
être placée n’importe où sur l’écran. La fenêtre Score a quatre pages onglets avec 
des étiquettes verticales sur la gauche, chacune présentant différentes vues de 
l’animation -- Score, Effects, Actions and Sounds, et Storyboard.  
 
La vue Score est semblable à la fenêtre de timeline (la ligne temporelle) des autres 
outils Flash. Elle montre les formes peuplant chaque image clé et fournit les 
fonctions d’édition des images clé et des formes... la vue Effects vous permet 
d’ajouter et de manipuler les effets. La vue Actions and Sounds permet d’ajouter 
des bruitages et des commandes d’action. La vue Storyboard présente des vignettes 
des images clés adjacentes de l’image courante. 
 

 
 
La barre d’entête affiche une graduation représentant les numéros des images clé. 
En dessous sont disposées les formes composant l’animation  ; à gauche le nom de 
ces formes et à droite, pour chaque image clé, un point indiquant leur présence 
dans l’image. Une forme sélectionnée est remplie en bleu. Cliquer sur un point 
sélectionne la forme et déplace l’animation jusqu’à l’image clé correspondant. 
 
Un clic droit sur l’image clé courante dans la règle du haut affiche un menu pop-up 
présentant un certain nombre d’options d’édition. 
 
Un clic droit sur une ou 
plusieurs formes 
invoque un menu popup 
avec les options de 
déplacement des 
formes à droite ou à 
gauche le long de la 
timeline. 
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La deuxième page d’onglet est la vue des effets. Cliquer sur le ‘+’ dans cette vue 
affiche un menu d’effets applicables à la forme sélectionnée. 
 
L’intervalle d’action de l’effet peut être modifié en tirant sur les boîtes identifiant 
celui-ci.  
 

  
Le troisième onglet affiche les sons et les commandes d’action. Cliquer sur le ‘+’ 
dans cette vue pour ajouter un son ou une commande. Double clic ou bouton droit 
pour afficher les propriétés de la fenêtre d’action. 
 

  
La dernière vue montre le storyboard sous forme de vignettes des images clé de 
l’animation  
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Vue d’ensemble de l’animation 
[Movie Overview]  

 
Cet écran fournit une liste détaillées de toutes les images clé, formes, actions et 
sons de ces images. Le bouton de droite bascule l’affichage des sons ou des actions. 
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Tutorials en ligne 
http://www.koolmoves.com/fsupport.html propose une série de tutorials en ligne. 
Les utilisateurs du logiciel peuvent contribuer en proposant leurs propres tutorials.  
 
On trouvera des exemples de scripts d’action sur 
http://necromanthus.com/main.html ; http://www.bridel.org/ ; 
http://www.geboortegrond.nl/km/ 
 
http://www.flashkit.com/tutorials/index.shtml 
est très riche en tutorials sur les techniques Flash. 

http://www.koolmoves.com/fsupport.html
http://necromanthus.com/main.html
http://www.bridel.org/
http://www.geboortegrond.nl/km/
http://www.flashkit.com/tutorials/index.shtml
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Vues des données 

 
Il y a cinq vues des données importantes. Popriétés des formes [Properties of 
Selected Shapes], score/timeline, vue d’ensemble de l’animation [Movie Overview], 
liste des formes dans l’image clé courante et liste de toutes les images. Properties, 
Score et Movie Overview sont placés côte à côte dans la palette d’outils supérieure 
et peuvent également être trouvés dans le menu Views. 
 
1) Presque toutes les propriétés 
de forme sont accessibles depuis 
la fenêtre de propriétés. C’est la 
plus importante des vues de 
données et des popups.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
2) Une vue très efficace de l'animation est obtenue par la fenêtre Score. Celle-ci 
flotte sur votre zone de travail et peut être placée n'importe où sur l’écran. Elle a 
quatre sous-vues  -- Score, Effects, Actions and Sounds, et Storyboard. La vue 
Score montre les forme peuplant de images et fournit les fonctions d’édition des 
images et des formes. La vue Score est équivalente à la vue timeline dans d'autres 
outils de Flash. La vue Effects, obtenue en cliquant l'étiquette Effects, fournit un 
environnement de visualisation et de manipulation des effets. 
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3) La vue d'ensemble [Movie Overview] fournit une liste détaillée de toutes les 
images, forme dans les images, actions, sons, boutons et clips.  

 
 4) La fenêtre liste de formes, qui peut être placée 
n'importe où sur l’écran et redimensionnée en tirant le 
coin inférieur droit avec la sourispermet de verrouiller 
des formes, de voir quelles formes sont des masques et 
lesquelles sont masquées, de 
couper/copier/coller/suppriper des formes et de 
repositionner les formes en arrière plan. Les groupes de 
formes sont afffichés comme une hiérarchie dans 
l'arbre des formes. Des formes dans l'espace d'édition 
peuvent être sélectionnées en cliquant leurs noms. Un 
nom de forme peut être changé en sélectionnant son 
nom à la soouris, en re-cliquant pour pour obtenir un 
curseur et saisissant au clavier un nom nouveau.  
 
 
 
 
 
 
 
 
 
 
 
 
 

 5) La liste des images clé peut être employée pour aller 
d’image en image, les renommer, les éditer (couper, 
copier, coller, changer l’ordre des images). Pour changer la 
position d'une ou plusieurs images ou pour couper/copier/ 
coller des images, faites votre sélection dans la liste 
d'images et employez les commandes d'édition de droite. 
Touche shift pour sélectionner plusieurs images. Collez 
place l’image coupée (ou copiée) avant l'image courante. 
Pour renommer une image, sélectionnez la dans la liste et 
cliquez une seconde fois pour obtenir un curseur. Saisissez 
le nouveau nom. La fenêtre peut être redimensionnée en 
glissant à la souris le coin inférieur droit. 
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Ajout et édition de texte 
En cliquant l’outil Texte sur la palette 
d’outils de gauche sous l’outil de 
création de forme, une fenêtre de 
dialogue vous permet d’adapter le texte 
: police, style, taille, espacement des 
lettres... Saisissez votre texte dans la 

grande boîte d’édition.  
 
Vous pouvez éditer le texte sélectionné en double-cliquant sur le texte ou en 
cliquant avec le bouton droit et en sélectionnant les Propriétés. Redimensionner, 
faire tourner, retourner et les transformations d’étirement affecteront le texte. Vous 
ne pouvez cependant pas manipuler les points associés à un objet texte. Si vous 
voulez tout de même le faire, convertissez le texte en formes avec des sommets 
(menu Transforms). 
 
Vous pouvez aussi ajouter un texte dynamique qui 
permet la saisie par l’utilisateur ou qui peut être 
modifié en cours d’animation. Cela est développé à 
la rubrique Texte dynamique.  
 
Les textes normaux sont excessivement filtrés pour éviter le crénelage dans la 
visionneuse Flash et deviennent flou dans les petites tailles... Cette dificulté ne peut 
pas être traitée par KoolMoves. FFF Compact est un bon choix de police de caractère 
pour les petites tailles. Les textes dynamiques sont peu filtrés et sont correctement 
restitués dans les pages HTML. 
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Glossaire français de la vidéo et du cinéma 
Un site universitaire canadien consacré au traitement des images vidéo, l'animation 
3D et le montage sonore animé par Sylvain Lamoureux, enseignant au programme 
des Techniques d'intégration multimédia du Cégep de Sainte-Foy. 
http://ici.cegep-ste-foy.qc.ca/profs/slamoureux/glossaire_video.htm 
 
Un glossaire du cinéma 
http://www.ccvaf.ch/ 
 

Avertissement du traducteur 
Le glossaire français des termes de la vidéo est fortement américanisé. Il ne m’a 
pas semblé judicieux de traduire « timeline » par ligne temporelle, ni « score » par 
tableau d’affichage. Par contre j’ai systématiquement traduit « frame » par « image 
clé » en raison de l’ambiguïté de ce terme qui signifie cadre. J’ai eu plus de difficulté 
à traduire « tweens » car le terme « jumelles » n’est pas vraiment adapté. J’ai donc 
préféré « images intermédiaires » ou « trames intermédiaires » bien que le terme 
« trame » ne soit pas correct pour la vidéo numérique. 
 
Enfin je n’ai pas traduit les items des menus, la francisation du logiciel KoolMoves 
n’étant pasà l’ordre du jour. 
 
Je suis bien sûr tout à fait disposé à corriger ces choix de traduction (et les erreurs 
et fautes de syntaxe éventuelles qui me seront signalées). 
 

Jean Fruitet – jean.fruitet@free.fr 
 

http://ici.cegep-ste-foy.qc.ca/profs/slamoureux/glossaire_video.htm
http://www.ccvaf.ch/
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